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PREFACE

This manual explains how to use the Control Techniques PLC Operator Station products and
CTIU software.

Copyright © 1999 Control Techniques PLC, The Gro Pool Road Newtown Powys UK SY16 3AJ.
All rights reserved. No part of this publication may be reproduced, transmitted, transcribed,
stored in a retrieval system, or translated into any language or computer language, in any form
by any means, electronic, mechanical, magnetic, optical, chemical, manual or otherwise, without
the prior agreement and written permission of Control Techniques PLC.

Information in this document is subject to change without notice and does not represent a
commitment on the part of Control Techniques PLC.

Windows 950, Windows 980, and Windows NT[ are registered trademarks of Microsoft
Corporation.

DeviceNet is a trademark of Open DeviceNet Vendors Association (ODVA).

Profibus is a trademark of Siemens.

Cscape, CsCAN, and SmartStack are trademarks of Horner APG, LLC.

For user manual updates, your nearest Control Techniques Drive Centre.

Limited Warranty and limitation of liability

Control Techniques PLC. ("CT-PLC") warrants to the original purchaser that the Operator Station distributed by CT-
PLC is free from defects in material and workmanship under normal use and service. The obligation of CT-PLC under
this warranty shall be limited to the repair or exchange of any part or parts which may prove defective under normal use
and service within eighteen (18) months from the date of manufacture or one (1) year from the date of installation by the
original purchaser whichever occurs first, such defect to be disclosed to the satisfaction of CT-PLC after examination by
CT-PLC of the allegedly defective part or parts. THIS WARRANTY IS EXPRESSLY IN LIEU OF ALL OTHER
WARRANTIES EXPRESSED OR IMPLIED INCLUDING THE WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR USE AND OF ALL OTHER OBLIGATIONS OR LIABILITIES AND CT-PLC NEITHER ASSUMES, NOR
AUTHORIZES ANY OTHER PERSON TO ASSUME FOR CT-PLC, ANY OTHER LIABILITY IN CONNECTION WITH
THE SALE OF THE Operator Station. THIS WARRANTY SHALL NOT APPLY TO THE Operator Station OR ANY
PART THEREOF WHICH HAS BEEN SUBJECT TO ACCIDENT, NEGLIGENCE, ALTERATION, ABUSE, OR MISUSE.
HE MAKES NO WARRANTY WHATSOEVER IN RESPECT TO ACCESSORIES OR PARTS NOT SUPPLIED BY HE.
THE TERM "ORIGINAL PURCHASER", AS USED IN THIS WARRANTY, SHALL BE DEEMED TO MEAN THAT
PERSON FOR WHOM THE Operator Station IS ORIGINALLY INSTALLED.

In no event, whether as a result of breach of contract, warranty, tort (including negligence) or otherwise, shall CT-PLC or
its suppliers be liable of any special, consequential, incidental or penal damages including, but not limited to, loss of
profit or revenues, loss of use of the products or any associated equipment, damage to associated equipment, cost of
capital, cost of substitute products, facilities, services or replacement power, down time costs, or claims of original
purchaser's customers for such damages.

To obtain warranty service, return the product to your drive centre with a description of the
problem, proof of purchase, post paid, insured and in a suitable package.
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About programming examples

Any example programs and program segments in this manual or provided on accompanying
diskettes are included solely for illustrative purposes. Due to the many variables and
requirements associated with any particular installation, Control Techniques PLC, LLC cannot
assume responsibility or liability for actual use based on the examples and diagrams. It is the
sole responsibility of the system designer utilising the Operator Station to appropriately design
the end system, to appropriately integrate the Operator Station and to make safety provisions
for the end equipment as is usual and customary in industrial applications as defined in any
codes or standards which apply.

NOTE: The programming examples shown in this manual are illustrative only.
Proper machine operation is the sole responsibility of the system integrator.

Declaration of EMC conformity

Disrtibutor’'s Name: Control Techniques PLC.
Distributor's Address: The Gro, Pool Road, Newtown, Powys, UK SY16 3AJ
Declares that the products Models: CTIU0O50, CTIU100, CTIU110 and

CTIU200

Conforms to the following EMC standards:

EMC: EN 55 022, Radiated and Conducted Emissions
EN 50 082-1, RF, EFT/EFB, ESD Immunity

Supplementary Information:

The above conformity only relates to the products in a stand-alone capacity. The products are
used as part of a system and are therefore classified as a component. As a component, the
products are prohibited by EC regulations to carry a CE Mark for EMC conformity. Static
discharge tests only apply to normal operation of the keyboards via the front panel. We would
stress that the use of our products within your system, while helping to ensure compliance of
your system to the same directives, do not necessarily guarantee that compliance will be
achieved. We would also like to point out that the interpretation of the law concerning CE
marking and its application to sub-assemblies and components is open to interpretation.

Date: 31 Mar 1999
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Revisions to this manual

This version (SSP-2050-1002) of the CTIU software Version 4.10 for the Operator Station
contains the following revisions, additions or deletions:

Added chapter detailing firmware upgrade. Section 1.5

Revised chapter on recipes.

Section on trending revised as per customer request.

Expanded the SmartStack chapter.

Added section on analogue meters.

Added section to text selector to include font size, and font editor.

Added section in download project to mention protocol check prior to download.
Changed TIU range specification table (Operating Temperature).

Added section explaining folder layout, and protocol file name.

Added new overlays for CTIU10X and CTIU11X.

Moved Key Mapping 7.7 and Function Keys 7.8 to the About Projects 8.17 and 8.18.
Revised operating temperature specifications in Table 1.2 (maximum temperature range).
Also revised part numbers listed under weight and dimensions.

m. Trending now available for the CTIU10X.

Add description internal, network and system registers.

0. Added sections on Control Techniques devices

S@meooop
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1. INTRODUCTION

1.1. General

The Operator Station (CTIU050/10X/11X/20X) is an Operator Station (OS) that provides
extensive monitoring and control in an extremely small package. The Operator Station “OS”
product line offers four distinct categories of products as described in Table 1.1.

Table 1.1 — Operator Station (OS) Product Line
Model | Description | Part Number
TIUO50: Text Only
CTIU050-001 2 lines x 20 characters. SSP-2050-0050
CTIU050-002 2 lines x 20 characters with Real Time Clock. (RTC) SSP-2050-0055
TIU10x: Text/ Semi-Graphics
CTIU100-01 8 Lines x 20 Characters plus 128 x 64 pixels. SSP-2050-0100
CTIU100-02 8 Lines x 20 Characters plus 128 x 64 pixels with RTC SSP-2050-0105
TIU11x: Text/ Semi Graphics with Numeric Keypad
CTIU110-01 8 Lines x 20 Characters,128 x 64 pixels & numeric keypad. SSP-2050-0110
CTIU110-02 As CTIU110-01 plus RTC SSP-2050-0115
TIU20X: Text/ Full Graphics with Numeric / Function Keypad
CTIU200 16 Lines x 40 Characters plus 240 x 128 pixels plus a Numeric | SSP-2050-0200
keypad / Function keypad. Optional SmartStack /0.

The front panel of the OS has a bright and clear display (LCD with adjustable back lit) and easy-
to-use push buttons. On the back panel are communication ports for connection to automation
equipment (programmable logic controller, drive, weighing equipment or other equipment) and a
PC (IBM or compatible computer). Also located on the back panel of the OS are clearly
displayed features such as power input, PC and PLC port, Tx and Rx LEDs.

The OS supports a variety of protocols. Various protocols can be downloaded through the PC
port and stored in the unit’s flash memory. The operating system can also be downloaded
through the PC port.

The OS has a total of 300 menu and sub-menu pages (password protection available). Each
page is capable of displaying up to eight embedded data items of the following types; numeric,
alphanumeric, timer, bit status, Horizontal Fill, Text Selector, System Variable, Password, Clock
Calendar, Data registers, Timer, Counter pre-sets and also internal bits in the automation
equipment (AE) may be edited via the OS. Other features include display of status information
and priority driven handling.

The CTIU100/110 is available with two non-standard features: 20mA current loop
communication and a real-time clock (RTC). Both can be ordered at the time of purchase. The
current loop can be re-fit by the user later. The RTC requires factor re-fit. The CTIU050 is only
available with the real-time clock option.

The CTIU20X provides for the display of both text and full graphics and has a Numeric/Function
Keypad.
It also allows the use of a wide range of SmartStack 1/O options.

CTIU configuration package, Control Techniques’ Windows[I-based software, is easy-to-use.
The software user’s guide is contained in this manual. (See Section 1.4 for initial software
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installation procedures.) All revisions of software from Version 1.34 can be obtained from your
nearest Control Techniques Drive Centre

Note: The Help File in the Software contains similar information to this manual.

1.2. Equipment Needed

Software Installation CD.

A PC Windows 9501, Windows 980 or Windows NT[J.

Approximately 15.7 MB of available hard disk space.

CTIU050/10X/11X/20X Interface Unit.

PC to TIU Programming Cable (PN) SSP-2050-0900 or equivalent (See Fig 2.6).

aghrwnpE

PAGE 12 INTRODUCTION CTIU User Manual Issue 2




1.3. Technical Specifications

Table 1.2 — Technical Specifications

Parameter Conditions Min. Typical Max. nits
Input voltage (V1) 10 24 32 VDC
Typical power consumption
CTIUO50 V| =24VDC 130
CTIU10X V| =24VDC 130 mA
CTIU11X Vi =24VDC 130
CTIU20X V| =24VDC 350
Inrush input current V| = 24VDC for 4ms 260 mA
Operating temperature
CTIUO50 0 50
CTIU10X 0 50
CTIU11X 0 50 °C
CTIU20XA 0 45
CTIU20XB or higher 0 50
Storage temperature -20 80 °C
Relative Humidity (non-condensing) 5 85 %
Weight
CTIUO50 320 350
CTIU10X 370 400
CTIU11X 470 500 9
CTIU20X 1870 1900
Dimensions
CTIUO50 179 x 111 x 60
CTIU10X 121 x 105 x 38 mm
CTIU11X 172 x 105 x 38
CTIU20X 282 x 194 x 62
Cable Lengths '
RS-232 15 m
RS-485 1 1500
IP rating NEMA 4-12/IP65

EMC Conformance

ENV 50144

EN 55 022, Radiated and Conducted Emissions
EN 61000-4-3, Radiated and Conducted RF Immunity

" Cables beyond the maximum recommended length may create communication problems. Both ends of
an RS-485 network must be properly terminated at 120Q and grounded.

1.4. Software Installation Instructions

1. Start your Windows[] Operating System.

2. Insert the Software Installation CD.

3. In Windows 9500, Windows 980, or NT 4.0, click the Windows Start menu button and
then click Run.
The Run dialog box appears.

4. Type D:\software\disk1\setup (CD Drive letter assumed to be D:) . Click OK.
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1.5. Upgrade Revision Software & Firmware

1.5.1 General

To avail of any new features that are included in this new release on units that were purchased
previous to this release, both software and firmware require updating by the user. Any new unit
will be set-up for the latest version released.

1.5.2 Software Upgrade

To update the software requires that the user install the new version of software from the
installation CD. You may install the new software over any previous version installed. See
section 1.4 Software Installation Instructions.

To update existing projects simple open the project from the newly installed version of the
software. Once the project is saved to disk the update is complete. For backup reasons we
recommend that you save the new version of your project in a different location or under a
different file name.

1.5.3 Firmware Upgrade

The following steps assume that a project or configuration is loaded to the Operator Station and
that the user is running the latest version of software.

a) Upload the project/configuration from the unit.

b) If a customised character set is loaded to the unit then upload the character set also.

¢) Choose Automation Device from main menu Configure/Communication Settings.

d) From File menu choose Update TIU Protocol. If you are updating from firmware version
3.00 or later then you just have to update to the latest protocol file. However if you are
updating from firmware version 2.00 or earlier you most update to a dummy protocol first,
then update to the latest firmware revision. See Note.(See updating protocol for further
information).

e) From File menu choose Update TIU Operating System. (See Updating Operating System
for more details).

f) Choose Download Character Sets to TIU from File menu.

g) Choose Download Project to TIU from File menu.

Note: When updating the protocol file the screen may go blank after the protocol file is complete.
Continue with the procedure as described and the display will recover.
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2. CTIUOS0

2.1. General

PAUSE Key
Alphanumeric
Keypad UP Key
Programmable
Function Keys
ENTER Key
DOWN Key

Figure 2.1 — Front View of CTIU050

2.1.1 CTIUO50 Button Selection Actions

PAUSE key selects data for editing OR exits from data editing.

PAUSE & DOWN keys pressed together, enters sub menu pages.

PAUSE & UP keys pressed together, exits sub menus to the parent menu pages.

UP key selects the previous menu page, sub menu page, alarms, and increments data
DOWN key selects the next menu page, sub menu page, alarms and also decrements
data.

ENTER key sends data to the automation equipment, accepts alarms, and displays
accepted alarms.

7. ALPHANUMERIC KEYPAD and PROGRAMMABLE KEYS can be used to enter data
or can be used to preform some pre-programmed action.

agrwdPE
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2.1.2 CTIUO50 Contrast Adjustment

On menu page 1 (after the start-up screen), hold the ENTER key and press the UP or DOWN
key to adjust the contrast. The contrast setting is stored and not lost after removing power.
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2.2. CTIUOS50 Ports
Pin 1 CTIUO50 8-pin Terminal Block

Tx+| Tx- [Rx+| Rx-|TxD| OV [RxD| L
RS422/485 RS232

Figure 2.2 Automation Equipment Serial Port

221 CTIUO50 Configuration of the RS-485 Port
@
1 TIU1XX p + (8|8
2 TX 2 RX i
3 Rx 3 Tx +
5 50V S0V
e
\ J ] ) L) J1
N AN
Figure 2.3 — PC Programming Serial Port
The Serial Pin connections for transmit (Tx), receive .
(Rx) and ground are displayed above. Figure 2.4 — Power Connector
Powered by +24VDC and Ground.
OFF

O000

43 2 1
SW1

Figure 2.5 — Configuration Bank

ON
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The configuration bank (shown in Figure 2.5) sets the parameters of the RS-485 port as
described in Table 2.1.

Table 2.1 — Configuration Bank

Switch 1 ON: Pull-up (must be used together with switch 3)

OFF: no Pull-up
Switch 2 ON: 120Q termination

OFF: no termination
Switch 3 ON: Pull-down (must be used together with switch 1)

OFF: no Pull-down
Switch 4 Reserved for future use
NOTE: Switch 1 and 3 must be used together. Either both pull-up and pull-down are
used or neither is used.

Pull-up and Pull-down switches are used to increase the signal level on the RS-485 bus. This
is useful if there is a long bus and a significant amount of attenuation is anticipated.

Termination resistance of 120Q must be placed across each end of the RS-485 bus. With

switch 2 ON, a 120Q resistance is placed across the bus. This is only used if the
CTIU050/100/110 is the last device at either end of the bus.

222 CTIUO50 Dimensions

5.95" [151mm]

3-27"jr0().i)()o2 [83jr00.b5 mm]

UP TO 0.04"[Tmm] CORNER

/RADIUSISA CEPTABLE

CTIUOS0 CUTOUT DETAILS

TOLERANCES ARE +/- 0.01" [0.3mm] UNLESS STATED OTHERWISE

Figure 2. 6 — CTIUO50 Cutout
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3. CTIU100/101

3.1. General
PAUSE Key ENTER Key
UP Key DOWN Key
Figure 3.1 - Front View of CTIU100
3.1.1 CTIU100 Button Selection Actions
1. PAUSE key selects data for editing OR exits from data editing.
2. PAUSE & DOWN keys pressed together, enters sub menu pages.
3. PAUSE & UP keys pressed together, exits sub menus to the parent menu pages.
4. UP key selects the previous menu page, sub menu page, alarms, and increments data
5. DOWN key selects the next menu page, sub menu page, alarms and also decrements

data.

6. ENTER key sends data to the automation equipment, accepts alarms, and displays
accepted alarms.
312 CTIU100 Contrast Adjustment

On menu page 1 (after the start-up screen), hold the ENTER key and press the UP or DOWN
key to adjust the contrast. The contrast setting is stored and not lost after removing power.
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3.2.

CTIU100 Rear View

321

® o
J3 m @)
+sv1x+'rx-|r«+ Rx-TxD|0V|RxD T+|T- [Re| R [ L
RS422/485 RS232 20mA Loop
Serlal Port PC Port
T Rx on
43 211 Tx O
| P
Serlal Port Rx
T
PC Port Model.
+|3[8
i Serlal No.
+
€
Figure 3.2 — Rear View of CTIU100/110
CTIU100 Ports
CTIU100/110 13-pin Terminal Block
Pin 1 / Pin 13
) |
® ® °® ° ® ® ° ® ° e ® e °®
N N A A A AN A AN AN A

+5V | Tx+

Tx-

Rx+

Rx-

TxD

ov

RxD

-
+

+
»
P
.||_

PAGE 20

RS422/485

RS232

Figure 3.3 — Automation Equipment Serial Port

CTIU100/101
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B | Rx B | Rx
B | Tx I | Tx

Serial Port PC Port

Figure 3.4 — Automation Figure 3.5 — PC Port Receive
Equipment Port Receive & & Transmit LEDs
Transmit LEDs The LED’s flash when the PC is
The LED’s flash when the communicating with the
CTIU100/110 is communicating. CTIU100/110
3.2.2 CTIU100 Configuration of the RS-485 Port

The configuration bank (shown in Figure 3.8) sets the parameters of the RS-485 port as
described in Table 3.1.

Table 3.1 — Configuration Bank

Switch 1 ON: Pull-up (must be used together with switch 3)

OFF: no Pull-up
Switch 2 ON: 120Q termination

OFF: no termination
Switch 3 ON: Pull-down (must be used together with switch 1)

OFF: no Pull-down
Switch 4 Reserved for future use
NOTE: Switch 1 and 3 must be used together. Either both pull-up and pull-down are
used or neither is used.

Pull-up and Pull-down switches are used to increase the signal level on the RS-485 bus. This
is useful if there is a long bus and a significant amount of attenuation is anticipated.

o
1 TIULXX PC
2 TX 2 Rx
3 RXx 3 Tx
S 50V 50V
_® )

Figure 3.6 — PC Programming Serial Port
The Serial Pin connections for transmit (Tx), receive (Rx) and ground are displayed above.
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L
t|8 g OFF
3 0000
ON
4 3 2 1
e o o[l SW1
N AN
Figure 3.7 — Power Connector Figure 3.8 — Configuration Bank

Powered by +24VDC and Ground.

Termination resistance of 120Q must be placed across each end of the RS-485 bus. With

switch 2 ON, a 120Q resistance is placed across the bus. This should only be used if the
CTIUO050/100/110 is the last device at either end of the bus.

3.3. CTIU10X Dimensions

- 394202100 mm] ]

3.270 02 183> mm]

UP TO 0.04"[Tmm] CORNER
RADIUS IS ACCEPTABLE

CTIUTOX CUTOUT DETAILS
TOLERANCES ARE +/- 0.01” [0.3mm] UNLESS STATED OTHERWISE

Figure 3.9 — CTIU10X Cutout
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4. CTIU110/111

4.1. General

Numeric Keypad

Programmable
Function Keys

|

(lu ¢ X€ (,._:'; )

Figure 4.1 — Front View of CTIU110

4.1.1 CTIU110 Button Selection Actions

PAUSE key selects data for editing OR exits from data editing.

PAUSE & DOWN keys pressed together, enters sub menu pages.

PAUSE & UP keys pressed together, exits sub menus to the parent menu pages.

UP key selects the previous menu page, sub menu page, alarms, and increments

data

DOWN key selects the next menu page, sub menu page, alarms and also

decrements data.

6. ENTER key sends data to the automation equipment, accepts alarms, and displays
accepted alarms.

7. ALPHANUMERIC KEYPAD and PROGRAMMABLE KEYS can be used to enter

data or can be used to preform some pre-programmed action.

PwbhPE

o

4.1.2 Contrast Adjustment

On menu page 1 (after the start-up screen), hold the ENTER key and press the UP or DOWN
key to adjust the contrast. The contrast setting is stored and not lost after removing power.
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4.2.

421

PAGE 24

CTIU110 Rear View

o |
J3 o

+5v1x+1x-|r«+ Rx-TxDlOVleD Te| T |Re| R| L
RS422/485 RS232 20mA Loop
TIT Ry SeralPort PG Port
J2
43 211 Tx O
1P
Serlal Port Rx
™
Model.
(3 8 PC Port
> Serlal No.
§
€
Figure 4.2 — Rear View of CTIU100/110
CTIU110 Ports
CTIU100/110 13-pin Terminal Block
Pin 1 Pin 13

+5V| Tx+| Tx- |Rx+| Rx-|TxD| OV |[RxD

.||_

T+| T- |R+| R-

RS422/485

RS232

20mA Loop

Figure 4.3 — Automation Equipment Serial Port

CTIU110/111
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B | Rx I | Rx
B | Tx B | Tx

Serial Port PC Port

Figure 4.5 — PC Port Receive
& Transmit LEDs
The LED’s flash when the PC is
communicating with the
CTIU100/110

Figure 4.4 — Automation
Equipment Port Receive &
Transmit LEDs
The LED’s flash when the
CTIU100/110 is communicating.

o
1 TIULXX PC
2 Tx 2 Rx
3 Rx 3 Tx
5 50V 50V
_® )

Figure 4.6 — PC Programming
Serial Port
The Serial Pin connections for transmit (Tx), receive
(Rx) and ground are displayed above.

+|3|8
3
+ 9688
ON
e o o
J1 43 2 1
SW1
Figure 4.7 — Power Connector . ) .
Powered by +24VDC and Ground. Figure 4.8 — Configuration Bank
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4.2.2 CTIU110 Configuration of the RS-485 Port

The configuration bank (shown in Figure 4.8) sets the parameters of the RS-485 port as
described in Table 4.1.

Table 4.1 — Configuration Bank

Switch 1 ON: Pull-up (must be used together with switch 3)

OFF: no Pull-up
Switch 2 ON: 120Q termination

OFF: no termination
Switch 3 ON: Pull-down (must be used together with switch 1)

OFF: no Pull-down
Switch 4 Reserved for future use
NOTE: Switch 1 and 3 must be used together. Either both pull-up and pull-down are
used or neither is used.

Pull-up and Pull-down switches are used to increase the signal level on the RS-485 bus. This
is useful if there is a long bus and a significant amount of attenuation is anticipated.

Termination resistance of 120Q must be placed across each end of the RS-485 bus. With

switch 2 ON, a 120Q resistance is placed across the bus. This should only be used if the
CTIU050/100/110 is the last device at either end of the bus.

4.3. CTIU11X Dimensions

5.95" [151mm]

3-27"jr0().i)()02 [83T00.65 mm]

UP TO 0.04"[Tmm] CORNER

/RADIUS IS ACCEPTABLE

CTIUT 1X CUTOUT DETAILS

TOLERANCES ARE +/- 0.01" [0.3mm] UNLESS STATED OTHERWISE

Figure 4.9 — CTIU11X Cutout
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CTIU 200

5.1.

5.1.

ogkhwnE

7.
8

5.1.

Figure 5.1 — Front View of CTIU20X

5.1 General
1 CTIU20X Button Selection Actions
PAUSE key selects data for editing OR exits from data editing.
PAUSE & DOWN keys pressed together, enters sub menu pages.
PAUSE & UP keys pressed together, exits sub menus to the parent menu pages.
UP key selects the previous menu page, sub menu page, alarms, and increments data
DOWN key selects the next menu page, sub menu page, alarms and also decrements data.
ENTER key sends data to the automation equipment, accepts alarms, and displays

accepted alarms.
ALPHANUMERIC KEYPAD can be used to enter data
PROGRAMMABLE KEYS can be used to preform some pre-programmed action.

2 Contrast Adjustment

On menu page 1 (after the start-up screen), hold the ENTER key and press the UP or DOWN

key

to adjust the contrast. The contrast setting is stored and not lost after removing power.
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5.2. CTIU20X Rear View

PLC
RX
L] ™ ]
SERIAL ] SMART STACK
Pomn(
RX D Serial No:
Model No:
OFF ON
1 [
3 |—
4 (T J5
" AR 2812 i
J B
PC Port E&Eég‘ﬁ‘g&\ ’75353;—‘&\8+
Figure 5.2 — Rear View of CTIU20X
521 CTIU20X Ports
Pin 1 CTIU20X 8-pin Terminal Block Pin 8

o« |

' v

.||_

Tx+| Tx- |Rx+| Rx-|TxD| OV |RxD
RS422/485 RS232

Figure 5.3 Automated Equipment Serial
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I | Rx B | Rx
B | Tx B | Tx

Serial Port PC Port

Figure 5.5 — PC Port Receive
& Transmit LEDs
The LED’s flash when the PC is
communicating with the
CTIU100/110

Figure 5.4 — Automation
Equipment Port Receive &
Transmit LEDs
The LED’s flash when the
CTIU100/110 is communicating.

Q
1 TIULXX PC
2 TXx 2 Rx
3 Rx 3 Tx
5 50V 50V
_® )

Figure 5.6 — PC Programming
Serial Port
The Serial Pin connections for transmit
(Tx), receive (Rx) and ground are
displayed above.

OFF

i}
o
+24V DC

O000

4 3 2 1
J1 SW1

ON

N AN

Figure 5.7 — Power Connector Figure 5.8 — Configuration Bank
Powered by +24VDC and Ground.
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522 CTIU20X Configuration of the RS-485 Port

The configuration bank (shown in Figure 2.23) sets the parameters of the RS-485 port as
described in Table 5.1.

Table 5.1 — Configuration Bank

Switch 1 ON: Pull-up (must be used together with switch 3)

OFF: no Pull-up
Switch 2 ON: 120Q termination

OFF: no termination
Switch 3 ON: Pull-down (must be used together with switch 1)

OFF: no Pull-down
Switch 4 Reserved for future use
NOTE: Switch 1 and 3 must be used together. Either both pull-up and pull-down are
used or neither is used.

Pull-up and Pull-down switches are used to increase the signal level on the RS-485 bus. This
is useful if there is a long bus and a significant amount of attenuation is anticipated.

Termination resistance of 120Q must be placed across each end of the RS-485 bus. With

switch 2 ON, a 120Q resistance is placed across the bus. This should only be used if the
CTIU050/10X/11X/20X is the last device at either end of the bus.

5.3. CTIU20X Dimensions

%9.75 0% (247 mm)

+0.02  +0.5
6.2" [167 mm
-0.0

—

-0.00
UP TO 0.04" Corner [RADIUS IS ACCEPTABLETmmM]

CTIU20X CUTOUT DETAILS

TOLERANCES ARE +/- 0.01" [0.3mm] UNLESS STATED OTHERWISE

Figure 5.9 — CTIU20X Cutout
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6. COMMUNICATIONS

6.1. Connection of Control Techniques devices
6.1.1 4 wire RS422/485 to UD71, Mentor, UD70, MD29, CDE, MC204

The ANSI (with menus) protocol using 4 wire RS485 has been supported by most of Control
Techniques’ products since the introduction of Mentor Il. The only recent products not
supporting 4 wire are Diverter A and Commander SE.

The modbus protocol on the UD70 series MD29 and MD29AN also uses this connection.
For multi drop connections simply connect the CT slave device connections in parallel.

CTIUT10/100

(Section of 13-pin

CT 9 way male D-Type

Terminal Block) Twisted pairs RS485 connection
o lTx+ |2 m m Pin 7 Rx
S [Tx- |3 Pin 3 RX
RS422/485 5 |Rx+ | 4 Pin 6 Tx
. 7 |Rx- |5 Pin 2 Tx
(4'W|re) a TxD | 6
|10V 7 Pin 1 0V (isolated)
™ |RxD | 8

CTIUO50/200

(Section of 8-pin

\‘Ljo.luF Ceramic

I

CT 9 way male D-Type

Terminal Block) _ . RS485 connection
(:,U) ] m Twisted pairs m Bin 7 Ry
S | Tx- | 2 Pin 3 Rx
RS422/485 OEO Rx+ | 3 Pin 6 Tx
. 9 1lRrx- | 4 Pin 2 Tx
(4 'W |re) 2 |TxD | 5
§ oV |6 Pin 1 0V (isolated)
™ |RxD | 7

Terminal strip connection
found on the CDEdrive
(Substitute for D type details
in drawing above)

Tb 3 Rx

Tb 2 RX

Th 5 Tx

Th 4 Tx

Th 1 0V (isolated)

Y,

.1uF Ceramic
T

Mini 8 pinTdin connection
found on MC 204 /216
(Substitute for D type details
in drawing above)

Pin 1 Rx +

Pin 2 Rx -

Pin 7 Tx +

Pin 8 Tx -

Pin 4 OV

Figure 6.1 Wiring for CT devices using 4 wire RS422/485
COMMUNICATIONS CTIU User Manual Issue 2
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6.1.2 RS-485 Two-Wire to UD7# , commander SE and Diverter A

CTIUT10/100 -

CT 9 way male D-Type

m m RS485 connection

o Tx+ |2 Pin 7 Rx
S| Tx- |3 Pin 3 RX
RS422/485 = [Rx+ [ 4 Pin 6 Tx
_ “|Rx- [5 Pin 2 Tx
(2-wire) [z]o]e o
oS(ov |7 Pin 1 0V (isolated)
~ (rxD |8

Y.

1

.1uF Ceramic

C |U050/200 CT 9 way male D-Type
m /\ RS485 connection
o lTx+ |1 Pin 7 Rx
o [Tx- |2 Pin 3 RX
N .
RS422/485 = [Rx+ | 3 Pin 6 Tx
m —
. ' [Rx- | 4 Pin 2 Tx
(2-wire) [z [mols -
§ ov |6 Pin 1 OV (isolated)
RxD | 7 y
0.1uF Ceramic
1 1
RJ45 connector on Terminal stri p on
Commander SE - Dinverter A -
(Substitute this for the (Substitute this for the
9 way connections shown 9 way connections shown
above) above)
Pin 2 Tx/Rx Tb C4 Tx/Rx
Pin 7 Tx/Rx Th C5 Tx/Rx
Pin 1 0V (isolated) Pin 1 0V (isolated)

This is the electrical standard for ANSI (with menus) protocol and Modbus using 2 wire RS485 &
is supported by Control Techniques’ more recent products.
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6.1.3 RS232 to UD71, UD7#

This electrical connection is used by the ANSI protocol on UD71 when RS232 is needed. It is
also used by the MD29MON protocol on the UD7# (not UD71), MD29 and MD29AN.

CTIUT10/100

(Section of 13-pin

Terminal Block) 7 ) /7~ 9 way female D type
- |ITxD | 6 Pin 3 Rx
R8232 § ov| 7 Pin 5 0V
™ 1IRxD | 8 Pin 2 Tx

[ T

CTIUO50/200

(Section of 8-pin

Terminal Block) 7\ 7~ 9 way female D type
o | TXD | 5 Pin 3 Rx
R8232 § ov| 6 Pin 5 0V
™M IRxD | 7 Pin 2 Tx

T

Figure 6.3 Wiring for CT devices using RS232

6.1.4 CTNet wiring guidance

CTNet bus CTNet bus

CTIU 200

Drive connector\ \/ \/ connector \/ \/

112|13]|4]5

=
N
w

Figure 6.4 CTNet wiring

Refer to chapter 16 for fitting details of CTNet SmartStack adapter. This protocol & hardware is
supported by MD29AN and UD75. A 78Q termination resistor will be required between Tb1 &
Tb2 if the CTIU is the last node on the bus. Refer to CTNet manual for further information on
wiring, cable lengths etc.
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6.1.5 Recommended Automation Equipment Communication Cables

Control Techniques recommends the following cables for drive and other automation equipment
communications using RS485:

Belden No. 8105, 9807 or 9832 — General Purpose
Belden No. 8165 — Heavy Noise Environment

For CTNet a special tested cable is avialable from Control Techniques, with part numbers:

SSP-3000-0050 50m Reel
SSP-3000-0100 100m Reel
SSP-3000-0200 200m Reel
6.2. Control Technigues Device Setup & Usage Details
6.2.1 Control Techniques ANSI comms protocol and the CTIU: Generalities.

¢ The unit uses Unidrive address rules so group addressing is supported; this means that the
default address (1) for mentor will not work with the unit. Mentors will need to be re-
addressed to Unidrive legal numbers (11-19, 21-29, 31-39 etc).

+ All parameters passed to and from the drive are handled by the CTIU as integers i.e. value
45.4 becomes 454 for reads (vice versa for writes) this is important when using the scaling
facilites, text lookups etc. Usually numerical drive parameters should be accessed as
signed 16 bit, (unsigned may be used if required but take care with range).

¢ When using the ANSI protocol, the unit can talk to 32bit virtual menus in the UD70 / MD29
but these will read as signed or unsigned 16 bit numbers — take care with the range used.
Alternatively 32 bit access can be turned on in the embedded field dialog in which case the
unit will look for 2 consecutive registers. treating the first as least significant 16 bits and the
second as most significant 16 bits, these two are then combined to give a signed or
unsigned 32 bit number. This feature cannot be used with menus 18, 19 & 20 as values are
restricted to +/- 32000.

¢ When using the Modbus RTU or ASCII protocol only 16 bit transfers are supported by CT
devices, The CTIU supports 32 bit transfers consequently do not select 32 bit transfers for
any field on the CTIU when using Modbus.

¢ When using the MD29MON protocol or CTNet 32bit registers in the PLC or other virtual
menu area will be read as 32 bit in a single transaction.

¢+ Group broadcast may be used provided drive 1 in the particular group exists (Unidrive only).

¢ Global broadcast may be used by sending to address O provided drive 11 exists, Mentor
broadcast is supported in this mode but the first drive must be address 11, other drives
should follow Unidrive address rules. With care mixed (Unidrive & Mentor) networks can be
supported for broadcast in this mode but all broadcast parameters should be integer.

¢ For CTNet communications using a CTIU 200 an optional CTNet SmartStack module is

required.
6.2.2 CTNet (UD75)
Function Parameter Comments
Node address #20.01 1-255
Speed (Kb/s) #20.02 0=5Mb/s, 1 =2.5Mbl/s .... 312.5Kb/s
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6.2.3 CTNet (MD29AN)

Function Parameter Comments
Node address #14.05 1-255
Speed (Kb/s) #11.01 0=5Mb/s, 1 =2.5Mb/s .... 312.5Kh/s
6.2.4 Mentor drive
Function Parameter Comments
Node address #11.11 Use Unidrive address rules (see note above)
Speed (Khb/s) #11.12 0=4.8,1=9.6
Mode #11.13 Must be setto 1
6.2.5 MD29
Function Parameter Comments
Node address #14.01 Uses Unidrive address rules
Mode #14.02 1 = 4 wire ansi, 5 = 2 wire ansi, 13 = Modbus RTU
14 = Modbus ASCII.
Speed (Kb/s) #14.03 Enter 1% 2 digits of required speed (1§t only for
speeds < 1000)

Parameters given for Mentor only, please check documentation for CDE, older MD29 capable
CT drives are not supported

6.2.6 Unidrive + UD71
Function Parameter Comments
Node address #11.23 Uses Unidrive address rules
Mode #11.24 0 = 2 wire ansi, 1 = 4 wire ansi
Speed (Khb/s) #11.25 0=4.8,1=9.6,2=19.2

6.2.7 Unidrive + UD7# (not UD71)
Function Parameter Comments
Node address #14.01 Uses Unidrive address rules
Mode #14.02 1 = 4 wire ansi, 5 = 2 wire ansi, 13 = Modbus RTU

14 = Modbus ASCII.
Speed (Kb/s) #14.03 Enter 1% 2 digits of required speed (1§t only for
speeds < 1000)

6.2.8 Commander SE
Function Parameter Comments
Node address #11.23 Uses Unidrive address rules
Mode #11.24 0 = 2 wire ansi, 1 = Modbus RTU
Speed (Kb/s) #11.25 0=4.8,1=9.6,2=19.2

6.2.9 CDE
Function Parameter Comments
Node address #11.23 Uses Unidrive address rules
Mode #11.24 0 = 4 wire ansi,
Speed (Khb/s) #11.25 0=4.8,1=9.6,2=19.2

6.2.10 Dinverter
Function Parameter Comments
Node address #b.23 Uses Unidrive address rules
Mode Fixed 2 wire ANSI
Speed Fixed at 4800

Menus a —f are not available to the CTIU.
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6.3. MC204 / 216

Although an ANSI program is available for the MC controller, we recommend the use of
Modbus protocol for the MC controller as it is simpler to set up.
To set up MODBUS RTU with MC2##

To set up the motion controller you need to execute 2 lines of basic.
ADDRESS =n
Where n is the number of the node

SETCOM(baudrate, databits, stopbits, parity,[port
number],[control])

Parameters Settings

baudrate: 1200, 2400,4800, 9600,19200 or 38400

databits: 7or 8

stopbits: lor 2

parity: O=none, 1=0dd, 2=even

port number: 0,1 or 2 (If not specified this parameter defaults to 0)

control: On channel #1 XON/XOFF can be made active or disabled: active,0=o0ff.
Setting value 4 activates the MODBUS RTU mode.

Note: On power up the controllers always set the serial ports to

9600,7,2,even, XON/XOFF active.
Suggested settings:

ADDRESS =1
SETCOM(19200, 8, 1, 0, PORT_No, 4)

With MC204

For RS232 Port_No should be 1
For RS485 Port_No. Should be 2

Limitations:
MC204 and MC202 can only support the protocol at baud rates up to 19200.

Version 1.48 of the MC system file can only handle 16 bit-unsigned variables, the next version
of the system file will fix this problem.
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6.4. Other  Automation Equipment  (AE) Communications
Connections

6.4.1 RS-232 Connection

CTIUT10/100

(Section of 13-pin

Terminal Block) 7N = AE
o | TxD | 6 Rx
RS232 |3 o] ov
M IRxD | 8 TX

T T

CTIUO50/200

(Section of 8-pin

Terminal Block) N AE
o | TxD | 5 RX
RS232 |3 e oV
M IRxD | 7 Tx

T T

Figure 6.5 — RS-232 Connection for other equipment

Note: Ground Connections at Both Ends.
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6.4.2

(Section of 13-pin
Terminal Block)

6.3.2 R5-422/485 Four-Wire

CTIUT10/100

RS422/485

Sy

S8vicey

Tx+

2

~

~

Tx-

Rx+

Rx-

(4-wire)

¢eesy

TxD

oV

RxD

o|[|Njoo|o]lb~|w

(Section of 8-pin
Terminal Block)

RS422/485
(4-wire)

T,

1

CTIU0S0/200

G8v/ccySY

Tx+

1

~

~

Tx-

Rx+

Rx-

¢eesy

TxD

oV

RxD

~N[ojg|h~lwN

.

1

Figure 6.6 — RS-422/485 4

AE (Examples)
GE
RXA RDA IN+ RDB

RXB RDB IN- RDA
TXA SDA OUT+ SDB
TXB SDB OUT- SDA

SG 0V GND COM

.1uF Ceramic

AE (Examples)
GE
RXA RDA IN+ RDB

RXB RDB IN- RDA
TXA SDA OUT+ SDB
TXB SDB OUT- SDA

SG 0V GND COM

.1uF Ceramic

Note: The descriptions used by different manufacturers for RS-422/485 connections vary.
Please refer to the automation equipment manufacturers own manuals for connection details.
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6.4.3 6.3.3 RS485 2 wire

CTIUT10/100
A AN

Tx/Rx+
Tx/Rx-

Tx+
Tx-
Rx+
Rx-
TxD
ov
RxD

RS422/485
(2-wire)

COM

Y0.1uF Ceramic
Y $

CTIUOS0/200
A AN

Tx/Rx+
Tx/RX-

¢ECSY | S8¥/2eySH

|Vl lw|N

Tx+
Tx-
Rx+
Rx-
TxD
ov
RxD

RS422/485
(2-wire)

COM

Y0.1uF Ceramic
Y I

¢EeSd | S8v/eerSy

~Njojo bW IN |-

Figure 6.7 — RS-485 Two-
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7. GETTING STARTED

7.1. Self-Test

Power up the unit with the UP and ENTER keys pressed at the same time. The unit enters a
self-test mode. The self-test consists of the following four checks:

Contrast Band
This test allows the user to set the lower and upper limits of contrast. Adjust the lower limit using the UP or
DOWN key and press Enter when done. Do the same for the upper limit.

Display Test
The display test continuously blinks all pixels on (black) to off. Look for any pixels stuck on or
off. Exit this test by pressing and holding any key for approximately two seconds.

Keyboard Test

As each key is pressed, an indication Fkk appears above that key. In the case of units with a
numeric keypad, press the key and a message appears indicating the key press. Check for
keys indicating multiple presses or not reporting presses. Exit this test by pressing and holding
any key for approximately two seconds.

RAM Test

Test either segment 0000 or segment 1000 (on the CTIU100/110) of the RAM. The segment
1000 test performs a base 3 repeating test. This test detects shorted address lines and
damaged memory bits. The segment 0000 test performs a Read-Modify-Write test on each byte
of RAM, detecting damaged memory bits. Exit this test by selecting DONE.

7.2. Serial Loop-back Tests

Tests the PC port and the Serial Port in each of it's three modes for serial loop-back. Pre-made
plugs are required to link the pins of a particular port. This takes the following form:

Table 7.1 Loop-back Test Plugs

Port Tested Product Type of Connector Pins to Short

PC (J2) CTIU100/110 Pin male D link connector | pin 2 to pin 3

RS-232 (J3) CTIU100/110 13-pin phoenix connection | pin 6 to pin 8

RS-422/485 (J3) CTIU100/110 13-pin phoenix connection | pin 2 to pin 4 and pin
3 to pin 5.

Current Loop CTIU100/110 13-pin phoenix connection | pin 1to 9, pin 10 to
1llandpin12to7

PC CTIU050 Pin male D link connector | pin 2 to pin 3

RS-232 CTIU050 8-pin phoenix connection Pin 5 to pin 7

RS-422/485 CTIU050 8-pin phoenix connection Pin 1 to pin 3, Pin 2
topin4

NOTE: current loop in not installed on standard models, as such a standard model will fail the
current loop-back test. Current Loop is not an option on the CTIU050/20X.

After starting the test, the OK counter begins to count up. Exit this test by selecting DONE.
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7.3. Selecting the Automation Equipment

The following points are covered in this section:

a. Connecting a PC to the CTIU050/100/110/20X;

b. Choosing the drive or PLC connected to the CTIU050/100/110/20X see also sec 6.2.
C. Selecting the protocol to be used.

1. Install the CT/U software on your PC (if not already done). Double-click on CTIU Software

icon; and the default screen shown below appears.

Untitled - CTIU Configuration Package
File Configure Edit Goto Yiew Help

2l=E| 8| Ble| 8l &l O] =5 ¥
J"oll@l!”T n|n|F||£|
e P ) s = s WS 1

( THRC X6, (“"’"

For Help. press F1 {Fenu 1 1) oL o [ROW D |

/

2. From Configure , ¢ Figure 7.1 - Default Screen

3. Connect the CTIU050/10X/11X/20X (PC Port) to a serial (COM1, 2, 3 or 4) on the PC.
From the Configure menu, choose PC Comms Por_t and the applicable Comm port.

4. Connect power (+24VDC) to the CTIU050/10X/11X/20X. Power-up the unit. The type of
protocol currently installed is displayed in the lower half of the screen during power-up.

5. If the automation equipment is different than the protocol currently installed on the
CTIU050/100/110/20X, a new protocol must be loaded.
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6. From the Configure menu, click Communication Settings

and select manufacture of the

automation equipment, followed by the type. The default setting for this equipment will be

displayed in the window. Click OK to accept.

7. ANSI

If the default setting does not match the communications settings of the automation
equipment, select the appropriate Baud Rate , and Communication Mode (see below, for

CT equipment the Parity , Data Bits , Stop Bits do not need to be changed)

7.2.
CTNet

. See figure

Simply select the Baud rate appropriate for the network you are going to connect t and the
HMI node address for the CTIU unit. In most cases the default value of 255 will be
appropriate and will only need to be changed if another unit is already using this address,

Both

If you are connecting to a single node

leaving network mode unchecked

enter the appropriate Global Remote Node ID
. For multidrop installations check the box and you will

need to enter the required node for each embedded field on your display,

Configure Link To Remote Equipment

Select Remote Equipment b anufacturer

Select Remote Equipment Model

]|

2'wfiire R5485 AMSI328 j

—Baud Rate Farity — Data Bitz
€ 38400 " None " Eight
19200 " 0dd ¥ Seven
8500 % Even

= 4800 — Stop Bits
2400 * One
1200 ) T
300

Communication Mode

[R5 485 Two wire |

[~ Metwork Mode Enable

Global Remote Mode D |1 1

Cancel | ak. I

Configure Link To Bemote Equipment

Select Remote Equipment b anutacturer
I Control Techrigues j

Select Remote Equipment kodel

I CTret j

— Baud Rate
& BpBaud
™ 2 BiBaud
" 1.25MBaud
"~ E25kBaud
" 312 5kBaud

Timeout Imzecz]

v

Gt Femete Hade D |1
HMI Mebwark Mode |255

Cancel | Ok I

Figure 7.2 — AE Configuration Boxes showing ANSI & CTNet setups
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8. To update the protocol, select Eile, then Update TIU P_rotocol . The programming tool
should select the correct folder for you. (Older versions did not select this folder
automatically: the default path is C:\Program files\control
techniques\CTIU\protocols\(0xx,1xx, or 2xx for 50, 100 or 200). The appropriate file for the
selected the automation equipment, will be displayed in the file name window. Click OK. A
“SYSTEM SHUTDOWN” message appears on the CTIU050/10X/11X/20X.

9. Once this is done you can change comms speeds, address etc without having to
download the protocol again. These details are also downloaded with the screen
configuration, and so can be easily changed.

7.4. Details for setting up standard serial comms

7.4.1 Communication Mode settings available for standard serial comms.

The Tiu is capable of operating in a number of electrical standards and the comunication mode
selection box is used to indicate which should be used. The selection made effects only the
electrical standard used to implement the serial link, not the data so transferred.

i.e. selecting modbus and RS422/485 Four Wire (Tiu Slave) does not make the unit function as
a modbus slave, merely as a master whose transmitters are turned off when not transmitting.

The modes supported are...
RS422/485 Four Wire (Tiu Master)

Both the RS422 transmitters and the receivers are permanently enabled. Choose this option
where the connected device uses a four wire link and the Tiu is the master on the link.

RS232
Choose this option where a basic three wire RS232 link is required with no handshaking.

RS485 Two Wire

Here the RS422 transmitters are enabled only when the terminal is sending data. The receivers
are switched off when transmitting but switched on at all other times. Choose this setting when
using a two wire RS485 link

Current Loop

Here the current loop receiver and transmitter are permanently enabled. The current loop option
requires a pair of current loop driver chips to be fitted to the terminal. Some terminals are not
capable of upgrade. (Only Tui100 and Tiul10 are) Choose this setting when the device to be
connected to has a current loop interface (Also described as 4-20 mA loop interface).

RS422/485 Four Wire (Tiu Slave)

The RS422 transmitter is enabled whenever data is being transmitted but the receivers are
permanently enabled. Choose this option where the connected device uses a four wire link, but
the Tiu is one of a number of slaves on the link.

RS232 With Active CTS

Here the RS422 Rx Input is treated as a clear to send. This is achieved by tying Rx+ (RS422)
To 0OV and feeding the CTS input into Rx- (RS485). Use RS232 transmit and receive as normal.
Use this option where the slave device is slow and will switch off CTS to indicate it is not ready
to accept data.

7.4.2 Protocol selection details for Control Techniques devices.

Devices not supported:
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Any older CT drive not using a Mentor Il style menu & parameter set, this includes
¢ All vector product prior to Unidrive

* & & O o o

¢ Diverter B
Summary protocol details for supported devices are given below

Commander CD / CD2 open loop drives (the New Commander SE is supported)
Mentor 1
Spindax
Dynamax
Digitax
Dominax

Device Protocols supported baud rate range Electrical mode

Mentor I ANSI328 4.8 — 9.6 Kb/s RS485

Md29 ANSI328, Modbus RTU, 0.3-38.4 Kb/s RS485 (not MD29MON)
Modbus ASCII, MD29MON RS232 (MD29MON only)

ubD71 ANSI328 4.8 —19.2 Kb/s RS485, RS232

Other UD7# ANSI328, Modbus RTU, 0.3-38.4Kb/s RS485 (not MD29MON)
Modbus ASCIl MD29MON RS232 (MD29MON only)

CDE ANSI328 4.8 —19.2 Kb/s RS485

MC204 /216 ANSI328, Modbus RTU 4.8 —19.2 Kb/s RS485, RS232

Diverter A ANSI328 (2 wire only) 4.8 Kb/s RS484 2 wire only

Commander SE | ANSI328 (2 wire only), 2.4 -19.2 Kb/s RS484 2 wire only
Modbus RTU

Refer to chapter 6 for further setup details for CT devices

Where available you should choose Modbus RTU (it is more efficient then ANSI) which you will
find in the Miscellaneous manufacturer section of the comms setup dialogue. Select 2 or 4 wire
from the communications mode menu (2 wire Modbus with UD7# / MD29 is supported from
V2.8 firmware onwards).

If you use ANSI in 4 wire mode (or RS232 with UD71) then choose ANSI 4 wire (On CTIU
software prior to May 2000 this protocol is denoted as Unidrive or Mentor), from the remote
equipment model menu in the dialogue. If you are using 4 wire this will also support the CDE.
Then select either RS422/485 4 wire (TIU master) or RS232 in the communications mode
menu.

If you use ansi in 2 wire mode then choose “2 wire RS485 ANSI 328" this supports all the 2
wire products. Then select RS485 2 wire in the communications mode menu.

7.4.3 Choice of data rate

The maximum data exchange rate available depends on the device in use and varies between
9600Kb/s up to 38400 Kb/s at the time of writing. With the recommended cable and correct
installation the best choice of speed is the fastest available on the device. With UD70 & MD29
38400 is available but when the processor is heavily loaded for instance when running position
control plus an extensive user control program there may not be enough resource in the second
processor to service the serial port at this speed in which case use 19200Kb/s.
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7.5. Proving Communications

Connect the CTIU050/10X/11X/20X to the automated equipment using the cable drawing
provided.

titled - CTIU Configuration Package

(II; & (v (:-J.r

Figure 7.3 — Start-u p

The following steps verify communications between the CTIU050/10X/11X/20X and the
automation equipment. The figures shown here are for the CTIU100. Methods are exactly the
same for the all products in the TIU range.
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1. Click on the Wizards Icon &I in the tool bar and choose Comms Stats. The display
should then look like figure 7.3. Move the cursor to the line of dashes at the bottom of the
screen about 5 characters in and double click, your are presented with an array of
pushbuttons, click the top left one, and the dialog below should open.

Configure Humeric Embedded D ata Ed |

— Remate D ata Source

Remate Made [0 I'I1

Data Type I Drive Parameters j
Location I'I g

— Dizplay Format

j i 15-Bit = 32Bit

e,
I ™ Unzigned % Signed

— Edit™rite
[~ Enabled

— Range Checking
I= | Eriatile

| T T |I:|

el AT |I:|

— Scaling
[™ Enable
THIPA irairt IU Hemate ifmun ID

LI FRA st |55535 Brermate W Emimmu ||35535

— Aittributes
[ Flashing

Change Type Cancel | k. I

Figure 7.4 — Numeric data dialogue

Fill it in as shown. This will ensure that the CTIU polls the drive for data. Click Ok and you
should have a screen looking like figure 7.5

2. The settings can be saved. To do this, select Save Project As from File. Enter a file
name and click OK.

3. Download the project to the CTIU050/100/110. To do this, from the Eile menu select
Download Project to Tiu . A status bar appears indicating the progress of the download.
On the CTIU050/10X/11X/20X Display Screen, “SYSTEM SHUTDOWN?" appears. A
message of “Transfer Complete ” appears when the data has been successfully
downloaded.

Note: If the error “Link Failed” appears, check the cable connection between the PC and
CTIU050/10X/11X/20X.
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4. After the transfer, the CTIU050/10X/11X/20X resets itself and the correct automation
equipment type is shown temporarily on the Display Screen.

5. On the Display Screen, the “GOOD” number of communications should be equal to the

“TOTAL” number of communications. The content of the embedded data, on the top line,
depends on the existing data in that register of the PLC.

7.6. Icon Descriptions

The CTIU050/10X/11X/20X software main screen is shown in Figure 7.4. Along the top are

several short cut icons. Many are standard Windows[ icons, some however, are specific to the
CTIU, these are labeled.

—Main Toolbar

Page Wizard gutstomlsg font
Create Sub Menu Me tl;]p reC_Ipte it
Delete Page ath (script) editor

Insert Page SmartStack setup

2lzd| @ mip| B8] & | O @& s

Text toolbar
Graphic Editor
24 + 32 Text
12 x 16 Text
6 x 16 Text
6 x 8 Text
Embed data

uol JEed [

Animated toolbar
Format Numeric Data
Format Timer Data

Format Alphanumeric Data
Format Bit String Data
Format Clock Calender
Format password

= ‘_
S ETEDES I%I = 2 2l 27|

Format System Variable
Format Bar Graph
Format Analogue Meter
Format Recipe item
Format Graph

Format Trend

'\

Format Text selector
Format bitmap selector
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manual 1.cmec - CTIU Configuration Package
File Configure Edit Goto Yiew Help

azd| 8 B2 B & rel S| =]
s=E] = - «|a]A] 7]
I ) W = o W 1

For Help, press F1 [Meru 1 1) |COL D ROW D 2

Figure 7.6 — CTIU050/100/110 Software Screen

7.7. Up/Down Keys

Left clicking on the “Up” and “Down” keys on the project window has the same effect as “Up”
and “Down” key presses (i.e., scroll up/down through the current menus). Right clicking on the
“Up” and “Down” keys on the project window have the same effect as Ctrl-Page Up and Ctrl-
Page Down key presses (i.e., enter sub menu, and leave sub-menu, respectively). If a sub-
menu does not exist a message appears saying “This page does not have a sub-menu, would
you like to create one?” See Creating a sub-menu later in this manual.

7.8. Key Symbols

The symbols for the four keys can be added to display pages using the PC function keys F2-F5.
The keys are assigned as follows:
1. F2=PAUSE

2. F3=UP
3. F4=DOWN
4. F5=ENTER
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8. ABOUT PROJECTS

8.1. General

This chapter describes the procedure for configuring the CTIU050/10X/11X/20X. This includes
loading, saving, downloading, uploading, verifying and updating the protocol.

8.2. About TIU Terminal

This new feature allows the programmer to see what version level the connected terminal is at
and how it is configured. The information give is;

a. Operating System Version Level

b. Firmware Version Level

c. Protocol Version Level

d. Remote Equipment Manufacture

e. Remote Equipment Model

This can be used as a useful diagnostic tool when updating operating system and firmware.
From the main menu click Help/About TIU Terminal, a window similar to Fig 8.1 appears.

About Connected Terminal |
Operating System Yersion 1.50
Firmware Yersion 4.04
Protocol Yersion 1.02
Fiemate Equipment Manufacturer nknown Manufacturer
Remate Equipment Model Genenc PLC

Figure 8.1 About TIU Terminal Configuration

8.3. Creating a New Project

1. Select New from the File menu.
2. The following error message appears:

Mew Configuration

The selected command will eraze the configuration currently in memmary.
Do wou really wigh bo create a new configuration?

Cancel i

Figure 8.1 — New Project

3. Click OK.
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8.4. Opening a Project

1. Press the “open folder” icon on the program display screen or select Open Project from the
Eile menu.

2. Select the proper file name from the list of available projects (with “cmc” extension).

3. Click OK.

8.5. Saving a Project

1. If the project has been previously saved during the current session, press the “floppy” disk
icon on the program display screen or select Save Project from the File menu

2. If this is the first time saving this project to a file, select Save Project As from the Eile
menu.

3. Enter the file name and destination. Click OK.

8.6. Downloading a Project

8.6.1 General

Prior to the download the software checks if following conditions are correct: -
a) The correct TIU terminal is connected to the PC.

b) Checks the correct Protocol file is loaded to the terminal.

c) Checks the current revision operating system and firmware revision.

Note: If the message “Link Failed " appears, check the cables connecting the PC to the unit.

Note: If the message “This Terminal is fitted with the incorrect PLC protocol. Load the correct
protocol before loading the configuration into the terminal”. The project and the terminal are not
set-up for the same protocol. If the project is correct then download the correct protocol file to
the TIU.

1. Select Download Project from the Eile menu. A status bar appears; indicating the
download is in progress.

2. After the project has been downloaded, the message “Transfer Complete " appears.

3. After the transfer, the CTIU050/10X/11X/20X resets itself.

4. The downloaded project now runs.

8.7. Uploading a Project

1. Select Upload Project from the File menu.
2. A status bar appears; indicating the upload is in progress.

Note: If the message “Link Failed " appears, check the cables connecting the PC to the unit.

3. After the project has been uploaded, the message “Transfer Complete " appears.

8.8. Verifying a Project

1. Select Verify Project from the File menu.
2. A status bar appears indicating verification progress.
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8.9. Updating the Protocol

When the software is installed the user decides where the main CTIU folder resides. The default
structure when this manual was printed is:

C:
Program files

|—|:| Control Techniques
|—L__| CTIU V4-10N

Fonts
oS

Projects

Protocol

e

Tiu0OXX

Tiulxx

o

Tiu2xx

8.9.1 Directory descriptions
¢ Fonts: Default store for CTIU font definitions

¢ OS: the 3 CTIU operating system files are stores here (auto selected by program)
¢ Projects: use this for your project files
¢ Protocol: the various drive & PLC communication protocol files are in here.
¢ TIUOxx files for the CTIU50
¢ TIU1xx files for the CTIU100/110
¢ TIU2xx files for the CTIU200
8.9.2 Changing Protocols

In the protocol directory 3 folders are created, TIUOxx, TIU1xx and TIU2xx. The protocol files for
the different terminal is loaded into these folders. The protocol files for the CTIU050 are loaded
into TiuOxx, the protocaol files for the CTIU10X are loaded into Tiul0x and the protocol files for
the CTIU20X are loaded into Tiu20x.

The name of the protocol file is broken up into three section, the protocol, the main software
revsion and the terminal type that protocol file is for.

Protocol Name Software Revision . Terminal Type

Example

snp_R4.1xx

This is the protocaol file for release 4 software for the GE FANUC PLC, for the CTIU10X
dfl_R4.2xx

This is the protocol file for release 4 software for Allen Brabley PLC, for the CTIU20X

To Update Protocol File

1. Set Terminal Type

2. Set the required Automation Equipment in Communications Settings
3. Select Update TIU Protocol from the File menu.
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4. Select the folder of the terminal you have connected to the PC. The correct file will appear
for the terminal type selected and the Automation Equipment selected. Select that file and
click OK.

5. A status bar appears indicating download progress.

6. After the transfer, the CTIU050/10X/11X/20X resets itself. The correct PLC type is
displayed on the CTIU050/10X/11X/20X.

7. Next, the project loaded runs.

8.10. Updating the Operating System

1. Select Update Operating System from the Eile menu.

2. Choose the updated file with the “BIN” extension. Click OK.

3. A status bar appears indicating download progress.

4. During the download process, CTIU050/10X/11X/20X displays the message “SYSTEM

SHUTDOWN”.
8.11. Printing

The CTSW232 software has printout capability. To print, select Print from the File menu or
click on the Print icon. The system parameters (# of menu pages, # of alarm pages, # of status
pages, PLC type, port settings, communication configuration, and PLC station number) and all
of the pages are printed.

The printer set-up is selecting Printer Setup from the Eile menu. The printer set-up screen is
shown in Figure 8.3.

Frint Setup
~ .
Default printer Cancel |
[currently HP Lazerlet 55i on SMRE_SERVERYSLazerjetSsi]
' Specific printer: Dptions.... |

“SIRE SERVERSLaserets 51 Help |

— Orientation Faper Metwork. .. |
n, = Portrait Siget  [44 210297 mm =1
" Landscape |V§0urc:e: ITra_l,l 2 ;I

Figure 8.3 — Printer Set-up Box

8.12. To Insert a New Page

1. Click on the Insert Page Icon or from Edit choose Insert Page.
2. Pages can either be Insert After Current Page or Insert Before Current Page . Also,
select the number of pages to be inserted. Click OK.

Inzert Pages I

' Inzert After Current Page

" Insert Before Current Page

Mumber OF Pages To Inzert
Cancel | 1] 8 I

Figure 8.4 — Insert Pages Message
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3. If the user goes to the last page of the project and clicks on the down key the a messages
appears saying “There are no more pages in this menu, do you want to create some?” If the
OK button is pressed the above insert menu pages appears.

Default Page Type

(CTIU20X Only)

With the CTIU20X series there are two types of pages.
a. Text Page

b. Graphic Page

The CTIU Software maybe set-up create either type of page by default or alternatively the
software can be set up to display a warning message asking which type page is to be created
every time a page or pages is inserted. (Prompt On Page Creation).

Text Page

A text page in the CTIU20X is similar to the normal page created with the CTIU10X/11X, i.e. the
same functions that are available on the CTIU10X/11X are also available on a Text Page of the
CTIU20X. To avail of the extra graphic features of the CTIU20X a Graphic page most be
created.

Graphic Page
On a page maybe used to display all the features of the Text Page plus the extra features

available for a Graphic Page. See chapter on Graphic Editor for further details of features
available.

8.13. Download/Upload Character Set  (Not available with the CTIU050)

After new characters have been created with the character generator, these characters must be
downloaded to the TIU. Conversely, an existing character set in the TIU can be uploaded.

8.13.1 To Download a Character Set:

1. Select Download Character Set to Tiu from the Eile menu. A status bar appears;
indicating the download is in progress.

Note: If the message “Link Failed” appears, check the cables connecting the PC to the unit.

2. After the project has been downloaded, the message “Transfer Complete” appears. The
new character set is now loaded to the TIU.

8132 To Upload a Character set from the TIU:

1. Select Upload Character Set from the Eile menu.
2. A status bar appears; indicating the upload is in progress.
3. After the project has been uploaded, the message “Transfer Complete” appears.

8.14. Select Terminal Type
This software package supports the project of multiple Operator Stations (TIUS).
8.14.1 To select the Operator Station being used:

1. From Configure , pick Select Terminal Type and choose the model.
2. Choose the model or TIU being used. The screen changes to show the model just selected.
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8.15. Delete a Page

1. Go to the page to be deleted. Click on the Delete Page icon or from Edit choose Delete
Page.
2. The current page is deleted and the next page is displayed.

8.16. Font Size (Not available with the CTIU050)

There are four different Font Sizes: Normal, Double Height, Double Size (x2) and Four Times
Size (x4). The size of an entire line is set, individual words on a line cannot have a different size
then other words.

8.16.1 To change/set the Font Size of a line:

1. Click somewhere on the line to be adjusted.

2. Click on the desired Font icon. The size of the entire line is adjusted. Any characters
beyond the right border of the screen are maintained but not displayed in the CTIU software
or on the TIU.

8.17. Key Mapping

The keyboard can be mapped to PLC automation equipment along with the currently displayed
page number. This enables keys to be used in Jog/Instantaneous action modes. Sending the
page number allows the automation equipment to qualify the key states sent to ensure that the
function only operates on the correct page. The page number is written to the specified data
register, Page Mapping , and the keys are mapped into the next contiguous data register, Key
Mapping .

8.17.1 To enable key mapping:

1. From the Configure menu, select Keyboard Mapping .
2. Check the Enable box.
3. Choose the Register Type and the Map Page To Register . Click OK.

The Configure Key Mapping screen displays the data type, the active page number (from
which the keys are active) and the keyboard mapping bits. For example, page 3 is intended to
cause a jog forward when up key is pressed, jog back when down key is pressed, and home
when the enter key is pressed.

Configure K.eyboard Mapping |

Target Hode ID D

Data Type | Words j|

Page |z Mapped In 1]
Keysz Are Mapped In 1

Cancel | 0K I

Figure 8.5 - Configure Keyboard Mapping Box
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8.18. Function Keys

8.18.1 General

The CTIU050/10X/11X/20X support function keys to be assigned in the project. The Up, Down,
Pause and Enter key can be configured as function keys however are defined on a per page
basis. Due to the fact that the keys may have other functions allocated to them the following
restrictions are placed on the allocation of functions to these keys:

1. The Pause key is available for mapping on status pages, alarm pages, and menu pages
with no editable embedded data, and which are not part of a submenu, and which do not
have a submenu.

2. The Enter key is available for mapping on status pages, alarm pages and menu pages ,
except the first menu page.

3. The Down Key is available for mapping on status pages and on the last page of a sub
menu.

4. The Up Key is available for mapping on status pages and on the first page of a sub menu.
(It is used for scrolling purposes on menu pages that are not the first in a submenu, and on
alarm pages.)

Along with the Up, Down, Pause and Enter keys, the alphanumeric keypad on the
CTIU050/11X/20X can also be assigned functions in the CTIU software. These function keys
can be programmed on all page types and menus.

The Configure Function Key Screen lists the available function keys on each page. See Figure
8.6.

Configure Function Keys |

Select a key from the List

Key 02 - : Digabled
Key 03 - : Dizabled
Kep D4 : : Dizabled
Kepy 05 - : Dizabled
Kep D6 : : Dizabled
Key OF - - Dizabled
Key 08 - : Dizabled
Kep 09 : : izabled
Kepy 10 - : Digabled
Pause :Local : Disabled
Up :Local : Disabled
Down :Local : Dizabled

Cancel |

Figure 8.6 Configure Function Keys for the CTIU11X

Double Click on the key to be programmed. Each key maybe programmed as a Global or Local
function key. Programmed as a Local function, the key will only complete the function in the
present page only. Programmed as a Global function, the key will perform the function on every
page of the project.
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Note: The Up, Down, Pause and Enter keys can only be programmed as Local Function
Keys.

The Key Actions for both Local and Global are:

1. Disabled

2. Push Button

3. Preset Register

4. Display Page

5. Ramp Register

6. Set Bit

7. Clear Bit

8. Invert Bit

9. Execute Maths

Function Key Defintion |
— Global Function Key Defintion Key Type
Key Action Di = & Global
Puzh Button Local
Prezet Register
Display Page |
R amp Register
S5et Bit -
= Locall Function Key [Vefintion
Fey Achion Dizahled j|
Cancel |
Figure 8.7 Function Key Definition
1. Disabled

Default setting, change to any other of the setting to enable function key.

2. Push Button
Sets the register chosen in the Location and Set Data type to the value in the Value field while
the button is pressed. The register is reset when the button is released.

3. Preset Register.
Sets the register chosen in the Location and Set Data type to the value in the Value field.

4. Display Page
Displays the specified page in the Page Number field.

5. Ramp Register

Increases the value of the Data Type or register type specified under the Location field by the
value entered in the Value field.

6. SetBit

Sets the bit specified in the Bit field of the Location, of the Data Type or register type to “1".
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7. Clear Bit
Sets the bit specified in the Bit field of the Location, of the Data Type or register type to “0”.

8. Invert Bit
Toggles the bit specified in the Bit field of the Location, of the Data Type or register type.

9. Execute Maths
Executes mathematic function beginning at the specified line number.
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NOTES
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9. EMBEDDED DATA

9.1. General

On the CTIU050/10X/11X up to 8 embedded data fields may be placed on each page. On the
CTIU20X up to 64 embedded data fields may be placed on each page. Embedded data types
are numeric (monitor or editable), alphanumeric (monitor only on the CTIU10X, editable on all
other models), timer (monitor or editable), bit status (monitor or editable), system variable
(monitor only), password (entry only in operation), Horizontal Fill, Text Selector, Recipe item,
and Clock Calendar. Many of the sections in this chapter contain specific instructions

that are intended to serve as examples only.

Note: If range checking is enabled, then increments and decrements are only allowed between
the maximum and minimum ranges.

There are 4 ways to embed data onto the screen.
a. Double click the Display window area.

HuE
b. Click the Embed Data icon —|
c. Chose Edit/Embedded data from the menu.
d. Press Shift and Enter Keys together.

If you double click the display window area or click the Embed Data icon the following screen
appears (Fig 9.1). From this the programmer can pick which type of data they wish to embed.

Alphanumeric Data Type Timer Data Type Bit status Password

Select L ata Display Format

: ABC [On|
Numeric 123 123 g‘% oOff|

Data Type / o
Clock Calendar / B 4 ﬁ /VE ~ IQ*\\Trend
\

Recipe Item /

~<Graph

Analog Meter / ~System
Variable
Text Selector ~
Analog
Bit Map
Selector

Figure 9.1 — Chose Embedded Data Type
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9.2. Numeric Data

From the Embedded data list select Numeric Data , the screen shown in Figure 9.2 appears.

Configure Humeric Embedded Data !
—FRemote Data Source
Remote Mode D il:l
Data Type
Location
— Digplay Format
&+ 16-Bit i 32Eit
o = 1 2
i J & Unsigned { Sigred
— EditArite
[ Enabled
— Fange Checking
= Enatile . ID
=R ;EI
= Sealing
[" Enable
TRt iﬂ Eenmate finimum ID
T FA i Rimar IE;5535 Frematehiasinmunm |55535
— Attributes
" Flashing
Change Type | Cancel | ] I
Figure 9.2 — Numeric Data Type Box
1. Select a Data Type (register or other) and enter a number for the Location (100 for
example).

Note: For numbers 0-65535, use 16 Bit Unsigned format. For numbers 0-999999999, use
32-Bit U nsigned format. When 32-bit is selected two contiguous registers are read from the
automation equipment. The first register read contains the low word and the second register
contains the high word. The data source register specifies the first of two registers.

2. If 16 Bit and Signed is chosen from Format, then numbers -32768 TO 32767 may be
utilised.
3. The signed, 32-Bit format for numbers -999999999 to 999999999 may be selected by

clicking on 32-Bit and Signed .
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9.2.1 To edit numeric data:

1. Check the Edit\Write box.
2. To enable range checking, check the Range Checking box and enter a Maximum and
Minimum range number (100 and 5 for example).

9.2.2 To change data registers contents from the CTIU050/10X/11X/20X:

1. Press the Pause key to select the data field for editing. The selected field becomes

highlighted.

To increment the data, press the Up key.

To decrement the data, press the Down key.

4. On Terminals CTIU050/11X/20X the numeric pad may be used as an easier way to enter
data.

5. To enter the data to the PLC, press the Enter key. If range checking is active, then
increment and decrement are only allowed between the maximum and minimum ranges.

wn

9.3. Alphanumeric Data

9.3.1 General

From the Embedded data list select Alphanumeric Data , the screen shown in Figure 9.3
appears.

Configure Alphanumeric Embedded Data ’

—Remate Data Source
R ermote Mode 1D iEI

Data Tepe

Location

— Digplay Farmat

Mumber Of Characters i1 G

— Edit"Afrite
™| Enabled

= AittribLites
[ Flashing

Change Type Cancel | k. I

Figure 9.3 — Alphanumeric Data
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9.3.2 To embed alphanumeric data:

1. Select Data Type. Enter a number for the Location (100 for example).
2. Enter the Number Of Characters to be displayed. One character is a byte (8 bits). To
have 10 characters, five registers are read.

9.4, Timers

94.1 General
From the Embedded data list select Timers, the screen shown in Figure 9.4 appears.

Configure Timer Embedded Data

16-Bit MM:55 -

'

I Enatie P Irra; ;
il I ;

r

{1 g e EnEtE e I

NIRRT e T

Figure 9.4 — Timers
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9.4.2 To monitor Timers on the CTIUO50/10X/11X/20X.

1. Select a Data Type, and enter Location number.
2. Select a timer format under Format. Table 6.1 shows the available timer format. A 32-bit
timer reads two contiguous registers.

3. Check the Edit Enable box to allow for the editing of the time format.

4. Check the Range Checking box to enter a Maximum and Minimum range .

5. Range checking can be entered in SECONDS; MINUTES, SECONDS; or HOURS,
MINUTES, SECONDS.

9.4.3 To edit the data field:

1. While displaying the appropriate page, press the Pause key to select the data field for
editing. The selected field becomes highlighted.

2. Toincrement the data, press the Up key.
3. To decrement the data, press the Down key.
4. To enter the day to the PLC, press the Enter key. If range checking is active, then
increment and decrement are only allowed between the maximum and minimum ranges.
Table 9.1 — Configurations for Timer Format
16-Bit MM:SS 12 Hour Minutes & Seconds
16-Bit HH:MM:SS 12 Hour Hours, Minutes & Seconds
16-Bit MM:SS T 12 Hour Minutes, Seconds & 10th of Seconds
16-Bit HH:MM:SS T 12 Hour Hours, Minutes, Seconds & 10th of Seconds*
16-Bit HH:MM 12 Hour Hours &Minutes.
32-Bit MM:SS 24 Hour Minutes & Seconds
32-Bit HH:MM:SS 24 Hour Hours, Minutes & Seconds
32-Bit MM:SS T 24 Hour Minutes, Seconds & 10th of Seconds
32 Bit HH:MM:SS T 24 Hour Hours, Minutes, Seconds & 10th of Seconds
32-Bit HH:MM 24 Hour Hours &Minutes
* up to a maximum of 1:49:13.5
9.5. Bit Status
9.5.1 General

This section describes the bit status functions available in the CTIU050/10X/11X/20X. Use the
instructions as follows to embed Bit Status.

From the Embedded data list select Bit Status

Select the Data Type (%l for example). Select Token Pair (“OFF"/"ON” for example).
Enter a number for the Location (register or other, 10 for example).

If a word Data Type is chosen, enter a Bit Number in the range of 0-15 under Format . If
bit 0 is off, then “OFF" is displayed. If bit O is on, then “ON” is displayed.

To modify a token pair, select the token pair to be modified.

Click Edit Tokens .

Enter the “ON” and “OFF” descriptions (up to 10 characters) in the Enter Bit On_Token and
Enter Bit Off Token boxes.

8. After being modified, the modified token pair can now be selected as normal.

el N

Noo
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Configure Bit Status Embedded Data !

—HRemaote Data Source

Remote Mode D IEI

Data Type
Lacatian IEI Bit Mumber IEI

= Dizplay Format

——— + 16Bit :
|"OFF7ON | a5 Edit Takens |

— Edit"frite
[ Enabled
—dttributes
[ Flashing
Change Type Cancel | k. I
Figure 9.5 — Configure Bit Status
9.5.2 To select the data field for editing:

1. From the appropriate page, press the Pause key. The selected field becomes highlighted.
2. To turn the bit off or on, press the Down key or the Up key and press “Enter” to send the
data to the PLC.
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9.6. System Variables

There are six different types of system variables. To embed system variables:

1. From the embedded data list select System Variable .
2. Select a system variable type under Select System Variable inthe Format section.
3. Click OK.

Configure System Generated Embedded Data i

—Remate Data Source
Internally Generated

— Digplay Format

= Attributes
" Flashing
Change Type Cancel 1 (] i
Figure 9.6 — Configure System Variable
9.7. Passwords
9.7.1 To password protect a sub-menu:

1. From the embedded data list select Password . A series of question marks appear on the

screen. Click OK
2. Select Create SubMenu from the Edit menu. Enter the number of pages, you then have

the option of password protecting the submenu.
3. There are two types of security access on sub-menus.
* Simply one password to enter the sub-menu
e Authority Level Mode

Configure Pazsword Embedded Data i

~Remote Data Source

[nternally Generated

= Attributes

Change Type Cancel 1 (] i

Figure 9.7 — Configure Password
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The Authority Level Mode allows the programmer to give security levels to each sub-menu.
Click Authority Level Mode and then enter the Authority Level to that sub-menu. Each Level can
be given an individual password.

Create SubMenu ;

Murnber Of Pages |1

|

V' Pazsward Protect
W Awtharity Level Mods
Lewel IIJ
— Authority Levels ——————— —
Level [ iD
Level 1 !D
Level 2 II:I
Level 3 II:I
Level 4 II:I
Level & II:I
Level B II:I
Level 7 II:I
Cancel | ITI

Figure 9.8 — Configure Password Authority Mode

9.7.2 To enter the password from the CTIU0O50/10X/11X/20X:

1. Inthe appropriate page, press the Pause key. The selected field becomes highlighted.

2. Enter the password by incrementing or decrementing the data field, by pressing the Up or
Down key respectively.

3. Press the Enter and Up keys simultaneously.

4. The data must be equal to the pass code in order to enter into the sub-menu.
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9.8. Analog Meters

An area of the display can be horizontally filled to create an analogue meter or gauge. The
height of the block is fixed at the height of the current text line. To create a horizontal fill:

1. From the embedded data list select Analog Meters . Select the Data Type and Location
under Data Source .

2. Type the Number of Characters under Format. The maximum width of the block is
determined by the width of the page and the character size.

3. Select the Maximum and Minimum range. Minimum and maximum values define empty
and full scale, respectively.

Configure Analog Metering Embedded D ata i

r Femaote Data Source
| Remote Node 1D i[l

Data Type

Lacatian

= Digplay Format

' 16-Bit & 32-Bit
Mumber Of Characters 312 & Unsigned " Signed

- Range

Minirmum ;EI

b @i ;EI

— Attributes
[ Flashing

Change Type Canicel 1 ] i

Figure 9.9 — Configure Analog Meters

| Note: Only 16-bit registers may be read from the PLC. Only linear scaling is supported.
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9.9. Text Selector

Text Tables are available in the CTIU050/10X/11X/20X CTIU software. There are 250 available
text tables for use and they may be numbered from 1 to 250. Each text table may have up to
256 entries (numbered 0 to 255). Entries within each table may be called up by using the
selected PLC register. When the ID of the entry is called up in the PLC register, the text string
(entry) is displayed. The text strings are automatically forced to the width of the longest text
string in the table (selected table). Strings are automatically left justified. Text tables are typically
used in situations where the operator desires a visual message when some event (such as a
value change in a register) occurs.

Example : A PLC is controlling a process that manufactures one of four drink types: Cola,
Lemonade, Orange Juice, and Apple Juice.

The PLC has a register that contains the value of “6” when Cola is being made, “8” when
lemonade is being made, “12” when Orange Juice is being made and “24” when Apple Juice is
being made. A Text table can be created with four entries, 6, 8, 12 and 24, with the text for
these items being the four products. Now, the PLC register can be monitored and the
appropriate text inserted into a page on the CTIU050/100/110.

A maximum of 64kBytes can be used by all of the text tables.

9.9.1 Edit Text Tables
Text tables can be edited from the CTIU050/100/110. To choose the Text Selector function:

1. Select Text Selector embedded data list.
2. Select a Data Type and choose a number for the Location . The value in the Location
(register or other) determines the text string (entry) number displayed (see 6.11).

Configure Text Selector Embedded Data !
— Remate Diata Source
Remaote Mode (D i[l
Data Tepe
Location
— Digplay Farmat
Table ID [1 Edt Table |
— Edit"Afrite
[ Enabled
= Attributes
[ Flashing
Change Type Cancel | k. I
Figure 9.10 — Configure Embedded Data
3. Select a text Table ID number (1-250).
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4. If you want the ability to edit the text string from the CTIUO50/10X/11X/20X, click the Edit
Enable box.

5. To create/edit/delete entries, click the Edit Table button.

6. A Text Table box appears and the user has the ability to Add, Delete, and Edit text strings.

To Add an Table Entry

1. Click Add Figure 9.11 is displayed.

2. The field ID is automatically the next the available number in the table. This can be changed
by typing in the number required or incremented using the up and down buttons to the right
of the field.

3. Inthe text field enter the text corresponding to that field ID.

4. The size of the font which the text will be displayed can then be set to the character set
sizes 6 x 8 or 12 x 16.

5. The programmer can enter the customised character generator by clicking edit font, see
Chapter on Character Generator for further details.

Text Table Field Ed |
Field ID hm jj
Text |I:|:|]_.5!
F EHEEH1E EditFDﬂt
12416, 24 8 32 —l
Cancel | Ok, I

Figure 9.11 — Text Table Field Entry

Text tables can be called in 3 different modes, Decimal , Binary and Hexadecimal . This refers
to the format of the data in the register calling the text table. Also in Binary mode multiple text
table entries can be displayed the user can then scroll between these text table entries, or set
the Auto Scroll option to let the TIU to automatically scroll between all the selected entries.

Text Table 1

o Cola
oo Or-ang e

Delete

Edit |
~Select Mode——
* Decimal i
= Binary ;

i Hexadecimal

||
|1_ Secands

[ Auto Mask Bits

[™ Defaulk Entry
1]

Export Table |
Cancel | ] | Impart T able |

Figure 9.12 — Edit Text Table Entries

9.9.2 To edit a text table from the CTIUO50/10X/11X/20X:
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1. Select the text string field by pressing the Pause key.
2. Move up or down the list using the Up and Down keys.
3. Press the Enter key to select the desired text string.

9.9.3 To Export/Import a Text Table

a. Export

1 Click the Export button.

2. Enter the location of the file.

3 Enter the name the file the text table is to be exported to.

b. Import
1. Click the Import button.
2 Click on the file to be imported.

9.9.4 Default Text Table Entries

If an undefined value is entered into the text table entry field (i.e., a value that has not been
assigned in any text table), then one of two different things happen.

a. |If the user has assigned a value to the Default Entry in the Text Table box, then that entry
number is displayed. This value is assigned by first checking the box next to Default Entry ,
then entering a number in the box below.

b. If the box is unchecked and a default entry has not been selected, then a series of asterisks
(corresponding to the longest entry in the text table) are displayed.

Example: There are four entries in the text table. These four entries have numbers of 23, 24,
54 and 67. The text in these entries is as follows:

23 - Cola

24 - Soda Water
54 - Apple Juice
67 - Orange Juice
100 Undefined

If an undefined value is entered (e.g. 97) then “*****xxxikkx? j5 shown. If a default entry has been

selected, i.e., 100 (any number can be used), then the text corresponding to 100, “Undefined ”
is displayed.
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Text Table 1 E2

023 Lola
024: Soda Water
054 Hpple Juice Delete |
o67: Orange Juice -
100: Undet ined Edit |
Select Mode
* Decimal
i Binary
= Hexadecimal
= Auto Seroll
EI Seconds
[ Default Entry
Cancel | oK |

Figure 9.13 — Text Table 1

9.10. Clock Calendar

If the CTIUO050/100/110 has been fitted with the real-time clock feature, then the time and/or
date can be embedded as data. To embed the time and/or date:

1. Select Clock Calendar under embedded data list.

Configure Clock Calendar Embedded Data

—HRemate Data Source

]|

The TILI will maintain the clock

arly if the Clack Option iz fitted.

Internally Generated
W arningl!l

during power down

— Dizplay Format

= Time Only
= Date Only
= Time First

Saome option combinations may

O MM/ADDAY
& DDMMAY

[ Show Centuny
¥ Show Seconds
™ Alpha Month
[T Show weekday

" arming 1

nat fit on a zingle line.

= Editrite

™| Enatled

- Aittributes

[ Flashing

Change Type

Cancel | (] I

Figure 9.14 —
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2. Choose the Format of the time and/or date to be displayed on the CTIU050/10X/11X/20X.
Click OK.

9.10.1 Clock Calendar Mapping

It is also possible to map the clock calendar (time and date) information to the automation
equipment. To do this:

1. From Configure , chose Clock Calendar Mapping .
2. Click Enable. Select the Data Type (register or other) and first register (or other) for the
Map Start. Click OK.

3. The mapping is displayed in the Map field (see Figure 6.13).
~Map

L~ d: ']

Data Type |Wolds j| HMinutes 1

T o :

Written

& Every Second :,‘:::h ;

" Every Minute D In Month 6
" Every Hour ays n ten

CE D Day OF Year 7

P Day Of Week 8

Warningll!

The TIU will maintain the clock
during power down
only if the Clock Option iz fitted.

0K I Cancel |

Figure 9.15 — Configure Clock Calendar Mapping

9.11. Menu Timeout

The Menu Timeout is a useful safety feature. This forces the CTIU050/100/110 back to the first
(main) menu page after a set time period. For example, the CTIU050/100/110 is on an input
menu page, after 30 seconds of no activity, the CTIU050/100/110 reverts back to the non-input
(safety) main menu page. To set the timeout:

Set Menu Timeout Ed

Enter Menu Timeout EI Seconds

Cancel | 1] 4 I

Figure 9.16 — Set Menu Timeout Box

From the configuration menu, select Configure , then Menu Timeout . A timeout is set in ALL
menu and sub-menu pages. Time-outs in each screen may be inhibited from the Edit menu. To
disable the Timeout function, set the time to 0 seconds.

9.12. Flashing Characters

The user may have flashing characters on any line and on any type of page in the project.
There are two different ways that flashing characters are implemented.
a. Inthe embedded data screen, under Attributes check the box for Flashing .
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b. The other way to create flashing characters is to use the “TAB” key when you are creating
the project. Flashing is toggled by line using the “TAB” key (current line the cursor is on). In
this case, the entire line flashes.

| Note: Flashing can not be enabled or disabled conditionally.

9.13. Set the Real-time Clock

The Real-time Clock is not a standard feature on all TIUs. The Real-time Clock is set from the
PC'’s clock. To automatically set the Real-time Clock from the PC's clock:

Connect the TIU to the PC.

From File, choose Set Clock. The PC's time is downloaded to the Unit

9.14. Scaling

Embedded Fields can be Scaled to convert register values from the AE into real-world numbers.
9.14.1 To enable Scaling:

1. From the Embedded Data screen, click Enable in the Scaling box.
2. Enter the TIU Minimum, TIU Maximum, Remote Minimum  and Remote Maximum .
3. After configuring any other fields, click OK.

The TIU Minimum and Maximum refer to the minimum and maximum values to be displayed
on the TIU. The Remote Minimum and Maximum refer to the minimum and maximum values
produced by the AE.

Example. Scaling can be used to convert the drive speed in RPM to a conveyor's speed in
m/min. This scaling could then be taking the gearbox and all the other mechanical factors into
account. The maximum sped of the drive may be 1450, but the actual maximum speed of the
conveyor is 100 m/min. Therefore, the Scaling configuration is as follows:

TIU Minimum 0 (m/min)
TIU Maximum 100 (m/min)
Remote Minimum 0 (RPM)
Remote Maximum 1450 (RPM)
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9.15. Page Wizard

The Page Wizard is a short cut for building pages to set or view the internal real-time clock or
view communication statistics.

Page Wizard |
— Page Type — Parameters
O ; {* Date Format DD /MMy

" View Clock " Date Format MM/DD /Y'Y

" Comms Stats
" Data Monitor
" Data E ditor

" 5elect Becipe

*Edit Becipe
= Picture Menu Warning!!!

The TIU will maintain the clock
£ Graph during power down
 View Trend only if the Clock Option i1z hitted.

" Password Entry

Build Page I Cancel |

Figure 9.17 — Page Wizard

9.15.1 To use the Page Wizard:

1. Move to or insert a page that is to be built.

2. Click the Page Wizard icon or from Configure , choose Page Wizard .

3. Click on the Page Type to be built and chose the particular Parameters to be displayed on
the TIU. Click Build Page .

9.16. Graphing (Not available with the CTIU050)

This features graphs up to two plots of 21 contiguous registers. Plot 1 is the lower byte of the
register and plot 2 is the upper byte of the register. The graph is updated continuously. The
actual update time depends on the equipment connected to the TIU, and communication speed.
The data structure is as follows:

Offset+0 Offset+1  Offset +2 .o Offset +21
Points Data 1 Data 2 L. Data 21

Points HIGH Byte = Number of point for plot 2
LOW Byte = Number of points for plot 1
Definitions: 0 = do not plot;
1 = plot first 11 registers on X-axis using 10 pixels per register;
2 = plot 21 registers on X-axis using 5 pixels per register;
>2 = assume 2.

Data HIGH Byte = Data for plot 2, ploted with a dotted line
LOW Byte = Data for plot 1, plotted with a solid line
The scale of the Y-axis is 0 to 29. Values greater than 29 or negative values are plotted
full scale.
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9.16.1 To Embed a Graph:

N

5.

Select Embedded Data from the Edit menu

Select Graph under Type.

Select a Data Type (register or other) and a Location (this is the First Data register, ).
Enter the number of points on the Graph, the number of points equals the number of data
registers required.

Click OK.

9.16.2 Enable Axes

When this option is selected the X and Y-axes of the Graph is displayed on the
CTIU11X/CTIU20X when the project is downloaded.

Note: The graph uses up 3/4 of a menu or submenu page and as such overwrites whatever data is on
that page.

Configure Graph Embedded Data ’

—Remate Data Source
R ermote Mode 1D iEI

Data Tepe

Locatian

— Digplay Farmat

Tiu Graph

—HRange

Mirirnamm IEI

b & IEI

— Attributes
™ Flashing
FntE
I™ Enable Axes Divisions i Sub-livisions i
T e
BN b l o A [ I

Change Type Cancel | (] I

Figure 9.18 Embedding A Graph
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9.17. Trending (Not available with the CTIUO50)

This features continuously plots up to two registers (channels) versus time. The maximum
update rate depends on the equipment connected to the TIU, and communication speed.

Configure Trend Embedded D ata !

—HRemaote Data Source
Remote Mode D IEI

Data Type

Lacatian

— Digplay Format
[ Contral D ata from Femate Device

izible Traces ——
Trend Width |1 minute j

2 1 |

[ Data Indirectly 5 pecified

—Hange

MininnLirn I

b & I

= fittribLites
[ Flashing
FRLE

I Enable Axes [Ihaions I_ U D [ ’.—
T

[iwismamns I St lsions i
Change Type Cancel | k. I

Figure 9.19 Embedding A Trend

9.17.1 Enable Axes
When this option is selected the X and Y-axes of the Trend are when the project is downloaded.

9.17.2 Data Indirectly Specified.

This option allows the programmer to indirectly specify the register which contains the data for
the trend, i.e. the contents of the register, which is specified in the Location section of the
Remote Data Source, specifies the register that contains the data for the trend.

9.17.3 Control Data from Remote Device

This option allows the programmer to control the set-up of the trend from registers stored in the
automation equipment. The structure for setting up the trend is described further in this
paragraph.

The data structure is as follows:

Offset +0 Offset +1 Offset +2 Offset +3 Offset +4 Offset +5
Time Base Ch.1Scale Ch.1Data Ch.2Scale Ch.2 Data Width
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Time Base 0 = maximum update rate;
1 = 1/10s per plot
X = X/10s per plot, up to X=10

Scale Maximum value of Y-axis for that channel; if 0 channel is not plotted.
Data Raw register values. Negative values are plotted at full scale.

Width Number of samples across the display
100 = 1 pixel per plot
50 = 2 pixels per plot
25 = 4 pixels per plot
10 = 10 pixels per plot
Any other value, the nearest to the above 4 is used.

If the Control Data from Remote Device option is not clicked then the trend is set-up as follows.

The Time Base is set by the Trend Width.

The scale is set by the Minimum and Maximum Range

The data for the first trace is taken from the register specified or indirectly specified in the
Location field

The data for the second trace is taken from the following register specified or indirectly specified
in the Location field.

Note: When Control Data from Remote Device is selected, the data to set-up the structure of the trend is
only read once, when you first go onto a screen where the trend is embedded. The data for the trend is
read continuously.

9.17.4 To Embed a Trend

Select Embedded Data from the Edit menu

Select Trend under Type.

Select a Data Type (register or other) and a Location .

To display axes with the graph, click the Enable Axes under Format.
Click OK.

agrwONE

Note: The trend uses up 3/4 of a menu or submenu page and as such overwrites whatever data is on that
page.
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NOTES
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10. CHARACTER GENERATOR

10.1. General (Not available on the CTIU050)

The CTIU software allows the user to edit, create and display on the CTIU10X/11X/20X special
characters. These characters may be company logos, special symbols or multilingual, non-
standard KEYBOARD characters such as Q, é, °, © or =.

Note: The character set for the font double height is scaled automatically from the 8x6-character set. The
character set for the font x4 is scaled automatically from the 16x12-character set.

Within each character set are up to 256 characters, however, not all these characters are
usable and/or editable by the user.

Table 10.1 — Make-up of a Character Set
Characters 0 to 31 System characters — not useable or editable
Characters 32 to 127 Standard keyboard characters — useable and editable although it
is not recommended the user edit these characters.
Characters 128 to 160 Editable and useable characters. This is the area of the
character set for use.
Characters 161 to 255 Extended keyboard characters — useable and editable although it
is not recommended the user edit these characters.

10.2. To Insert a Special Character:
1. Place the pointer on the display where the character is to go.
2. Press <Ctrl> <Enter> or by clicking right mouse button. Click on the character in the

Character Map (see Figure 10.2) to be inserted.
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10.3. To Create Or Edit a Character:
1. From Configure on the menu bar, choose Fonts. The screen in Figure 10.1 appears.

Character Size

Character Generator - H12BY16.HFH

—Character Bitmap [12 X 16) Code : 065 [0x41) A ~Ch Set /

A

&
Character Code 065 [0x41) A j

First Char Code

Hira DL E—
Face Name Master 12x16

Edit Std ASCIl -
/ No = (

Character Number

Character Size 12¥ 16 j

Name of Set

Edit Standard
keyboard Characters

Saves Character File

ﬂ
ARSI

-
Sorve i Tond File Loads Character File
Previous Next Map Hﬂ Convert | ] Doubles the Slze Of
| A\ <+« |  the8xGsetonly
Click on a square to toggle that square on or )
off or drag and draw white of black lines. Shows spacing

Figure 10.1 - Character Generator

2. Under Character Set , choose the Character Size to be edited. Beside Set Name,
enter a name that describes this set.

3. Click on Map to show the total character set. The screen in Figure 7.2 appears. The
first four rows are the standard keyboard characters, which should not normally be
edited. The fifth row is editable and useable. The lower three rows are the extended
keyboard characters, which may also be edited if you do not need the characters. Click
on the character to be edited or blank box to create a character.

Character Map X
4|

1"#$Z&’()*+,—.6E1234 3 K=Y
DEFIGHI|JKL ST [XYIZIENTS -

~ [alblc/dielf o[ ili k[Imnojplarstuvwyze o~
i|elE=NHE[ [ alel=| @[ =[=[2 3 | IM] - [ [T 2 [+l Palé
ARRIBRAECEEEE( 11T BNOOORIx[eLUUYPB
alalalaalaEcegledi|ii[T]sRooatlo]: | sy k¥

Char Width Char Height [16 |

Figure 10.2 — Character Map

NOTE: Standard and Extended keyboard character are editable; however, this must be done with caution
as it effects how characters are displayed on the CTIU050/100/110, i.e., changing “4” to « causes all 4's
from the drive to be displayed as . 454 is displayed as ¢5e.
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4. Under the Character Bitmap (see Figure 7.1), click on a square (pixel) to toggle that

square on or off. The grey area is the space between characters and these squares should not

be turned on.

5. Go to step 3 to edit the next character.

6. Once all the characters have been created or edited, click Save File. Choosing Yes
over-writes the current character file. Choosing No gives the option to save this
character set under a new file name.

Note: Itis possible to double the size of an 8x6-character set. To do this click on the Double button. Itis
not possible to half the size of a 12x16-character set. It is recommended that the 8x6-character set be
created first and then doubled.

10.4. International Keyboards

The CTIU software supports various international keyboard layouts. However, if the standard or
extended keyboard characters are edited or deleted, the pressed key may appear different or
not at all. The following keyboard layouts are supported:

Table 10.2 — Supported Keyboard Layouts
Danish German (Standard)
Dutch (Belgium) Italian (Standard)
Dutch (Standard) Norwegian
English (All) Spanish (Modern Sort)
Finnish Swedish
French (Standard)

PAGE 82 CHARACTER GENERATOR CTIU User Manual Issue 2




NOTES

CTIU User Manual Issue 2 CHARACTER GENERATOR PAGE 83




11. RECIPES

11.1. General

Recipes allow the user to send or update multiple registers simultaneously. For example, it may
be desired to run a vector motor at two different settings for two different applications.

a. Speed of 1000rpm, max torque 50%, acceleration rate of 100s 0 - max speed
and deceleration rate of 200s 0-max speed;

b. Speed of 500rpm max torque 40.0%, acceleration rate of 500s 0- max speed
and deceleration rate of 150s max speed.

Recipes enable the user to download all the fields (four in this example) at the same time
without editing each individual field.

11.2. To Enable Recipes:

1. From Configure, select Recipes. Enter the Recipe Name, Number of Records in the
Database and Number of Fields in Record . The number of Records and Fields can be
changed later. Click OK.

BY - Tiu Recipe Editor =] 3

Eile Edit ‘“iew Help

2l &= w

Field Record 1 Pecord 2
Speed | 1001 | 500
torque all 40
accel 100 200

decel s

For Help, prezs F1 | |N|-”"I v

Figure 11.1 Recipe Database Editor

2. The TIU Recipe Database Editor appears. Setthe number of Records (different settings)
and Fields (parameters).

3. Edit the Fields and Records as desired.

4. From File, select Exit to leave the Recipe Editor.

11.3. To Edit Recipe Fields and Records:

1. Open the Recipe Editor by clicking on the Recipe icon on the Toolbar or from
Configure /Recipes.

2. Leftclick on the Fieldto be edited. Enter the Ingredient Name, Type Remote Data
Source (register) and Format in the same manor as Embedded Data. Enable Scaling if
desired.

3. Left click on the Record to be edited. Enter the value and click OK or press <Enter>.

4. From Eile, select Exit to leave the Recipe Editor.
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11.4. To Rename a Record
1. Double click on the record name

Enter Record

Enter Walue IHEEDrd 1|

s I Cancel |

Figure 11.2 — Record Name

2. Type in the new record name
3. Click OK.

11.5. To Embed a Recipe Item on a Menu Page:

1. Select Embedded Data from the Edit menu.

Configure Recipe Item Embedded Data |

—Remaote Data Source

Internally Generated

— Digplay Format
' Fecipe Selector Field |Recipe Mame j
" Fecipe Field Tag
" Fecipe Field Contents

— Editwrite

i

Er e

— Attributes
[™ Flashing

Change Type Cancel | k. I

Figure 11.3 - Embed Recipe Item

2. Select Recipe Item.
3. Select Display Format.
Recipe Selector
« Recipe Name will allow the user to edit the contents of each Item of the displayed
Record; the Record name will be displayed.
« If one of the Items is selected then the user can edit the contents of each Item of the
displayed Record; the Record number will be displayed.
Recipe Field Tag
If this is embedded on the menu page then the Item Name of the record selected for that menu
page will be displayed.
Recipe Field Contents
If this is embedded on the menu page then the contents of the current Iltem, of the record
selected for that menu page, will be displayed.
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4. Click OK.

Note: A recipe item can be manually embedded on a menu page however for best results when

embedding a recipe item on a screen see the Page Menu Wizard for Recipe Items. This can always be
edited afterwards.

11.6. Importing and Exporting Data from a Recipe:

Recipe tables can be imported or exported. Files can be imported or exported as coma
delimited (*.csv) or as print files (*.prn). Other file types may be viewed but may not load
properly.

Note: Only Records are exported and imported, the Field names are not.

Note: If the table size that the data has been imported into is smaller then the table it was imported from,
then not all of the data is displayed.

Note: Only one Record column can be selected per project at any time.
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12. TUTORIAL

12.1. General

This chapter contains instructions for using several of the CTIU050/100/110 features. The
projects in this chapter serve as examples and are not to be taken literally for all applications.
After following this tutorial, the user should have a better understanding of how the
CTIU050/100/110 operates.

12.2. Menus

The CTIU050/100/110 supports a total of 300 pages divided between menu and sub-menu,
alarm and status pages. The following points are covered in this section:

Menus can have sub-menus.

Sub-menus can have sub-menus.

There may be up to 8 embedded data per page.

Embedded data can be displayed-type or entry/editing-type.
Sub-menus can be password protected.

agrLONE

Additional menu pages may be created by selecting Insert Page from the Edit menu or by
selecting the “+” icon from the icon menu to the right of the Display screen. Selecting Delete
Page from the Edit menu or by selecting the “-“ icon will delete the displayed page.

The next menu page may be selected by clicking the “Down” key or by selecting the Next Page
from the Goto menu. The previous menu page may be selected by clicking the “Up” key or by
selecting Previous Page from the Goto menu.

Example : The CTIU050/100/110 is used to monitor the temperature of a furnace and indicate
the heater or a fan is ON or OFF. This example uses a UD70 controller in a Unidrive, but is
applicable to any PLC with modifications.

12.2.1 Steps involved in building configuration.

1. Select communication Settings  from the Configure menu . Select the applicable
automation equipment being used, in this example a Control Techniques Unidrive is
used. Click OK. Update the Protocol if required.

2. Menu Page 1 shows some explanatory details about the program and should look like

figure 12.1. For “Furnace Control #1” on line 3, click on the font double height icon at
the beginning of the line.
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Figure 12.1 — Menu Page

3. Click on the Insert Page Icon. Choose Insert After Current Page . Click OK
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Untitled - CTIU Configuration Package =] B3
File  Configure Edit Goto View Help

2=|d] 8 e B8] & r O] @& s
sz = o alA] ~]
i P ] ) =1 s WSS 7

For Help. press F1 [Menu 2 (2] |COL15  [RON 2

Figure 12.2 — Menu Page

4, Enter the text as shown in Figure 12.2.

5. Place the cursor one space to the right of “Temperature” and embed a Numeric Data in
drive PARMETERS Location 70.00. Select “XXX”, 16-Bit, Unsigned . Click OK.
Correct “C” position.

6. On the first space of the fourth line, click the embed icon. Choose Analog Meter , drive
PARMETERS Location 70.01. Under Format, enter 15 for characters, 760 for
Maximum and O for Minimum . Click OK.

7. Place the cursor 6 space to the right of “Heater” and embed a Bit Status in drive
PARMETERS Location 70.02, bit number 0, Select Token Pair Format, “OFF"/"ON.”
Click OK.

8. Place the cursor 9 spaces to the right of “Fan” and embed a Bit Status in drive

PARMETERS Location 70.02, bit number 1, Select Token Pair Format,
“OFF"/"ONFF", Bit Number_1. Click OK.
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Unlilled - CTIU Configuration Package

File Configure Edit Goto Wiew Help

2=E| & Ble| B & rff & @] K
éﬁll@l!”T nlnlnlil
i e ] O e = s R

Qb (S (W (>

-

Far Help, press F1 [Meru 2 (2] |COL 15 [RON 2

Figure 12.3 — Menu Page

9. After embedding the data, the screen looks like Figure 12.3.
10. Under the File menu, click Download Project .

The temperature is displayed digitally and as a bar graph by the horizontal fill. Also, it is shown
whether the heater and fan are ON or OFF.

Note: For this example to work registers in the PLC area of the UD70 are used to simulate temperature,
heater and fan.

12.3. Sub-Menus

Sub-menu pages branch off menu pages analogous to a sub-directory branching off a main
directory of a PC. The CTIU050/100/110 supports a total of 300 pages divided between menu
and sub-menu, alarm and status pages.

Example : Continuing from the example in Figure 12.2, one sub-menu is set up for the heater
and one for the fan. Each sub-menu sets the temperature (within the furnace) at which the
heater or fan turns ON/OFF.

Note: Ladder code needs to be written if this example is to work as anything more than an example.

1. Go to menu page 2. Under the Create SubMenu page, choose 2 for the Number of
Pages. Be sure that the Password Protect box is unchecked. Click OK. The bottom
middle cell should display Menu Page 2.1 (indicating a sub-menu).
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2. After completing this, enter the text as shown on the first sub-menu page (as follows):
ntitled - CTIU Configuration Package

(G (@ (B D

Figure 12.4 — Sub-Menu Page 2.1

3. Embed data one space to the right of “ON Temperature” by selecting Numeric for the
Type, drive PARMETERS Location 70.03. Under Format, select “XXX”, 16-Bit
Unsigned and click on Edit Enable. Click OK.

4. Do the same as in step 3 for “OFF Temperature” but use Location 11.
5. On the sixth line, one space to the right of “Manual Override” embed a Bit Status in

drive PARMETERS Location 70.04, Select Token Pair Format, “OFF”/"ON”, Bit
Number_ 1, Click on Edit E nable. Click OK.
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7.

[E3 Untitled - CTIU Configuration Package

File Confiqure Edit Goto Wiew Help

2l 8| Ble| B K fr 5 @E] K
J‘E||@|!| |T i | n|F|| il
e = st O 0

G -.Ju

For Help, press F1 [Menu 2 2] [coL 19 [RO

Figure 12.5 - Sub-Menu Page 2.1

Highlight the display screen, and select Copy from the Edit menu. Select Next Page
from the Goto menu. Select Paste from the Edit Menu. Change the “Heater” to “Fan”
and Fan ON and OFF temperature registers to 70.05 and 70.06, respectively. Change
the Bit Number_ to 1 for the embedded data beside Manual Override.

Return to the parent menu by selecting Parent Menu from the Goto menu.

Under the Eile menu, you can Save Project , then Download Project.

The Screen appears as in Figure 12.5.

12.3.1

To Enter A Sub-Menu On the CTIUO50/10X/11X/20X:

To go into a sub-menu from the main menu, press the Pause key and the Down key at
the same time.

To edit the data, press the Pause key. Press the Down key to decrement the data, the
Up key to increment the data and the Enter key to enter the data.

Press the Pause key and the Up key to return to the parent menu or the Down key to
go to the next sub-menu page.
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12.4. Password-Protected Sub-Menus

This tutorial section of the manual covers how to create password-protected sub-menus.

Example : Continuing from the example in 12.2, one sub-menu is set up for the heater and
another for the fan. Each sub-menu sets the temperature (within the furnace) at which the
heater or fan turns ON/OFF. This is the same as the example in 12.3 except that the sub-menus
are now password protected.

1. Create a new menu page by selecting Insert Page from the Edit menu.
2. Enter the text, as shown in Figure 12.6.

Untitled - CTIU Confhiguration Package

File Configure Edit Goto “iew Help

2=z=| 8| Bla| Bl £ 5] @] v
plelm| & - [«f- A] 7|
e e e ) e = s A

Faor Help, press F1 |Meru 2 (2] |COL & [RON 2

Figure 12.7 - Password Enter Screen

3. Place the cursor one space to the right of “CODE” and select Embedded Data from the
Edit menu. Select Password for the Type. Click OK. Four question marks should
appear beside the word “CODE".

4, Go to menu page 3. Select the Modify SubMenu Properties , and choose 2 for the
Number of Pages Check the Password Protect box, and enter a Password of “1234",
Click OK. The bottom middle cell should display Menu Page 3.1 (indicating a sub-

menu).
5. Follow steps 2 through 8 in 9.3.
6. Save and Download Project to the CTIU050/100/110.
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The resulting display screen on the CTIU050/100/110 appears as the screen shown in Figure
12.7 (with a code of 0000).

12.4.1

12.4.2

ER Untitled - CTIU Configuration Package
File Configure Edit Goto Wiew Help

=8| 8| Bl B & f O] ®S] W
=B & ] f R| 7
e et 7 2 = ol T

'i("'ﬁ G (5 (D

For Help, press F1 [Meru 212) |coL 18 |ROY

Figure 12.7 - Password Enter Screen

To Enter the Sub-Menu:

Press the Pause key to edit the Pass Code.

Press the Up key to increment the code, 1234 in this example (hold the key down for
speed incrementing), the Down key to decrement the data and the Enter key to enter
the data.

Press the Pause key and the Down key at the same time to select the sub-menu page.
The sub-menu page is only selected if the Pass Code is correct.

To Edit The data On The Sub-Menu Pages:

Press the Pause key to select the field to edit.

Press the Up key to toggle or increment the field. Press the Down key to toddle or
decrement the field. Press the Enter key to send the value to the drive.

Press the Pause key to select the next field to edit.

Press the Pause key and the Up key at the same time to return to the parent menu.
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12.5. Status

The CTIU050/10X/11X/20X can display STATUS information. For example, a status page can
be displayed as COILS change (in real-time) in your drive, i.e., the first Coil displays the first
Status page, the second coil the second page and so on.

Status messages can have up to eight embedded data values per page. Up to 300 total pages
are available split between Status, Alarms and Menu pages.

Two different modes are available for configuring status pages. These modes are the Bit Mode
and the Direct Mode.

» Direct Mode reads only one register as a word from the drive for the status page. If the
value in this register is zero or greater than the number of configured status pages
in the system , the main menu screen is displayed. Otherwise, the appropriate status
screen is called up.

e Bit Mode works essentially the same, except that the screens are controlled by discrete
bits instead of the full word register values.

NOTE: Status pages are only displayed when MENU PAGE 1 is selected.

Example: The following example involves the CTIU050/10X/11X/20X connected to Unidrive &
UD70. Itis applicable to any of the supported automation equipment with substitutions made
for the specific registering nomenclature, i.e., 70.00 is a 32 bit multipurpose register which can
be mapped to the Beckhoff remote 1/0. It is assumed the drive is properly configured, the
CTIU050/10X/11X/20X is properly connected to the drive, both are powered up, and the CTIU
software, is running on the PC.

1. Select Communication Settings from the Configure menu. Select the automation
equipment type you are using. For the example here, a “Control Techniques Unidrive
protocol” is being used. Click OK.

2. Insert a menu page after Menu Page 1 (refer to 12.2 for instructions). Place the cursor
at the left on the first line. Click the double height icon. Type “Discrete Outputs:”

3. On the third line, type “ R1%.0". Click on the Embed Icon. Select Bit Status from
Type; Drive parameter from Data Type; Location 72.01, bit number 0 ; leave Token
Pair as “OFF"/"ON” and click Edit Enable . Click OK. See Figure 8.8.

4, Do the same for _R1%.1, R1%.2 and R1%.3 on lines 4, 5 and 6, incrementing the Bit

Number by one. These discrete outputs will simulate coils. Menu Page 2(2) should be
the same as Figure 12.9.
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Configure Bit Status Embedded Data

=1 Untitled - CTIU Configuration Package

.(IIJ (A: (YJ (--l:

Figure 12.9 — Menu Page 2(2)
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From Configure , choose Status . Click Direct Mode . From Data Type choose drive parameter
(72.01; Block Start equals 0. The Number of Status Pages equals 4. Click OK.

Figure 12.10 — Configure Status Pages

From View, choose Status . This displays the first of four status pages. On the third line, delete
what is there and type “Status Page:” on the fourth line, click on the x4 icon and type “1” in the
centre of the line. Status Page 1 appears as the screen in Figure 12.11. Highlight display
screen,

click Edit and Copy.

Untitled - CTIU Configuration Package

'(II > (A: (VJ (_4-11

Figure 12.11 — Configure Status
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Click the down arrow icon on the project software to get to Status Page 2 of 4. Delete what is
on the display screen, then from Edit, choose Paste Page. Change the “1” on line four to a “2.”
Do the same for pages 3 and 4.

From File, choose Download Project

( wpr (& (W (—""“

Figure 12.12 — Status Page 0

On the CTIU050/10X/11X/20X, press the DOWN key to get to the Discrete Output page (as in
Figure 12.8). Press the PAUSE key the toggle bit 0: ON by pressing the UP key and ENTER
key. Press the PAUSE key until nothing is highlighted (three times).

Press the UP key. The page shown in Figure 8.12 should be displayed.

Note: Status pages are only displayed from Menu Page 1.

5. Press the DOWN key and return to the Discrete Outputs page. Toggle bit 1:OFF and
bit 3:O0N. Return to Menu Page 1 by pressing the UP key. Now Status Page 4 is
displayed. This is because Direct Mode is selected and the register is being read as a
word, i.e., 0100 binary = 4.

6. Toggle bit 1: ON, bit 2: ON, bit 3: OFF and bit 4: OFF. Now Status screen 3 is
displayed (0110B=3).

7. Toggle bit 4: ON and all the other OFF. Now a screen with “Default Menu Screen”
written on the second line is displayed. The CTIU050/100/110 is looking for Status
Page 8 (1000B = 8), which does not exist, so the default screen is displayed.

8. In the CTIU software, choose Status from Configure . Click on Bit Mode . Click OK.
Download the project to the CTIU050/100/110.

9. Now Status Page 4 is displayed. In Bit Mode, the CTIU050/100/110 reads the register
as discrete bits, not as a word, i.e., 1000 triggers Status Page 4, 0100 triggers Status
Page 3, etc.
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12.6. Alarms

12.6.1 General

The CTIU050/100/110 can display ALARM information as BITS change in your drive (real-time).
The active alarms can be accepted and then SCROLLED through. Up to 300 total pages are
available split between Alarms, Status and Menu pages.

The CTIU050/100/110 also has an Alarm Acknowledge Table. This feature allows a set of bits
to be written back to the drive to indicate alarms that have been accepted by the user, but are
still “ON” in the drive table. These bits are in the same format as the “incoming” alarm bits. The
acknowledgement bits are set when an alarm has been acknowledged, provided that the
corresponding bit is still active in the alarm table. The acknowledgement bit is cleared when the
corresponding alarm bit is cleared. Click the Enable box to use the Alarm Acknowledge Table.

Example : The CTIU100 or 110 is connected to a Unidrive. Register _P20% AKA #70.20, bits 0
to 3 are the alarms. Register _P21% AKA #70.21, bits 0 to 3 are the acknowledgement table.
The instructions below are a tutorial of how to use the Alarms on the CTIU050/100/110.

Configure Alarms |

Alarm Data Source

Trarmer [{ade |1 1

Data Type IDrive Parameters j

Elack Start I?U.ED
Humber OF Alarms |4

Acknowledgement T able
¥ Enable

Data Type I Drive Parameters j

&k Table Start I?EI.21|
Cancel | k. I

Figure 12.13 — Alarm setup

1. Select Alarms from the Configure menu.

2. Set the Data Type to drive parameters. Enter the location of the Block Start as 70.20.

3. Enter the number of alarm pages in the Number Of Alarms box (4 for example). If the
number of alarms is greater than 16, then the next drive register is read.

4. Check the Acknowledgement Table Enable box. Set Data Type to drive parameters
and Block Start to #70.21. Click OK.

5. Insert a page (Page 2) after Page 1. Go to page 2. On the second line type “Alarm:”
and embed #70.20 beside. Make the embedded #70.20 field Numeric , two digits and
Edit Enabled with a Range Maximum of 15. This field acts as the alarms.

6. On the fourth line, type “Acknwldg Table:” and embed #70.21 beside. Make the
embedded #70.22 field Numeric and two digits. This field holds the Acknowledgement
table.

7. Select Alarms from the View menu. The bar at the bottom displays the alarm page

selected.
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The next alarm page can be selected by clicking the Down key or by selecting Next Page from
the Goto menu. The previous alarm page can be selected by clicking the Up key or by
selecting Previous Page from the Goto menu.

8. Enter text in Figure 12.14.

ER Untitled - CTIU Configuration Package | _ O] x]
File Configure Edit Goto “iew Help

al=d gl mla| = & el O =l 2
el & -1 fe Al ¥
i i e ] O ) [ e )

( B (A (B G --u

For Help, press F1 |larm Page: 001 [COL O {RC 2

Figure 12.14 - Alarm Page 1 Screen

9. Place the cursor beside either “ACCEPTED” OR “UNACCEPTED” and select
Embedded Data from the Edit menu or click the embedded data icon (X.X).

10. Select System Variable under Type and XXX Accepted Alarms or XXX Unaccepted
Alarms under Select System Variable in the Format section.

11. Block the entire page. From the Edit menu, select Copy (or type <Ctrl-C>).

12. Page down to Alarm Page 2 of 4 using Next Page from the Goto menu. Paste Page 1
to Page 2 using Paste from the Edit menu (or <Ctrl-V>). Do the same for alarm page 3
and 4.
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13. Download Project to the CTIU050/100/110. Put your drive in “RUN” mode.
On the CTIU050/100/110:

Scenario 1: energise alarm 1.  Go to page 2. Select the field beside “Alarm” by pressing the
Pause key. Change the value to 1 and press the Enter key.

Action : Alarm Page 1 is displayed. The user presses Enter. The alarm page goes away and
“Acknwldg Table:” (#70.21) equals 1 indicating alarm 1 has been acknowledged.

Scenario 2: energise alarm 3.  One page 2, change the Alarm field to O, press Enter. The
“Acknwldg Table:” field returns to 0 as well. Set the “Alarm” field to 4 (the CTIU050/100/110
read discrete bits for the alarms, so 0100 binary, i.e., bit 3 high equals 4 decimal).

Action : Alarm Page 3 is displayed. The user presses Enter. The alarm page goes away and
“Acknwldg Table:” (#70.21) equals 4 (i.e., bit 3 is high) indicating alarm 3 has been
acknowledged.

Scenario 3: energise alarms 1, 2 and 3.  One page 2, change the Alarm field to O, press
Enter. The “Acknwldg Table:” field returns to 0 as well. Set the “Alarm” field to 7 (the
CTIU050/100/110 read discrete bits for the alarms, so 0111 binary equals 7 decimal).

Action :

a. Alarm pages 1, 2 and 3 are active. Alarm page 1 is displayed as the first alarm. Until any
alarms are accepted, the Alarms Accepted reads 000 and the Alarms Unaccepted reads
003.

b. The next Active alarm page can be selected by pressing the Down key on the
CTIU050/100/110. The last Active alarm can be selected by pressing the Up key on the
CTIU050/100/110.

c. The Active Unaccepted Alarms can be accepted by pressing the Enter key on the
CTIU050/100/110. Only one alarm is accepted at a time. Once an alarm is accepted, the
next alarm is displayed. Accept all 3 alarms.

Go to page 1. Accepted Active Alarms can be recalled by pressing the Enter key. Accepted
Active Alarms are scrolled through with the Up key and the Down keys on the
CTIU050/100/110. Pressing the Enter key again returns display to page 1.

| Note: Active Unaccepted alarms are displayed as a priority on any page.
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13. GRAPHIC EDITOR

13.1. General

The TIU Graphic editor is designed to be a simple Drawing and Graphic Editor to be used with
the CTIU20X. The CTIU20X can have 2 types of pages, a Text Page and a Graphic Page . The
text page works similarly to the menu pages on the CTIU10X/11X. On Graphic pages, as well
as all the features of the text page, also includes many other graphical features, such as;
Shapes with 3 different backgrounds, bit maps and bit map animation.

All features are designed to be intuitive to the experienced user of Windows[] type applications.
The following paragraphs describe most of the features available, however hopefully the user
will find the software easy to use with some experimentation.

13.2. Draw Mode

Select a drawing mode by clicking on the appropriate button on the Shapes Toolbar, by
choosing Setting/Draw Mode from the main menu. Before drawing the object choose the
Background Fill (this maybe changed afterwards).

Line Arc Text Bit Map Editor Draw A Table

Shapes Toolbar

& plQlal NI& ) &

Rectangle Ellipse Rectangle Rounded Comers Pen Colours Back Ground Fill Colour

Figure 13.1 — The Shapes Toolbar

13.2.1 Selector

5]

The selector tool may be used to select objects or groups of objects already created. Select an
object by clicking on any part of the object. Set the properties of an object by double clicking on
the object.

To select all objects click Edit/Select All.

13.2.2 Rectangle

O

Select Rectangle Draw Mode .

Select the background and pen colour.

Move to a corner of the desired rectangle. Click and hold the left mouse button.

Drag the mouse to where the bottom right hand corner is to be located.

The Draw Mode returns to Selector as default

To edit the size of the rectangle click on the object, then click on one of the black dots
around the object. Drag this dot around on the screen and the rectangle will change size
automatically.

oukwNE
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13.2.3

Ellipse

Select Ellipse Draw Mode .

Select the background and pen colour.

Move to a corner of the desired ellipse. Click and hold the left mouse button.

Drag the mouse to where the bottom right hand corner is to be located.

The Draw Mode returns to Selector as default

To edit the size of the ellipse click on the object, then click on one of the black dots
around the object. Drag this dot around on the screen and the ellipse will change size
automatically.

Rectangle with Round Corners

Select Rectangle with Rounded Corners Draw Mode

Select the background and pen colour.

Move to a corner of the desired rectangle. Click and hold the left mouse button.

The Draw Mode returns to Selector as default

To edit the size of the ellipse click on the object, then click on one of the black dots
around the object. Drag this dot around on the screen and the ellipse will change size
automatically.

Line

Select Line Draw Mode .

Select the background and pen colour.

Move to a corner of the desired line. Click and hold the left mouse button.

Drag the mouse to where the second point is to be located is to be located.

The Draw Mode returns to Selector as default

To edit the size of the line and shape click on the object, then click on one of the black
dots around the object. Drag this dot around on the screen and the line will change size
automatically.

Arc

Select Arc Draw Mode .
Select the background and pen colour.
Move to a corner of the desired arc. Click and hold the left mouse button.

The Draw Mode returns to Selector as default.

1
2
3.
4. Drag the mouse to where the bottom right hand corner is to be located.
5
6

To edit the size of the arc and shape click on the object, then click on one of the black dots
around the object. Drag this dot around on the screen and the arc will change size
automatically.
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13.2.7 Text Mode

Select Text Mode .

The background on text mode is by default transparent (This can be edited later).
Click on the screen, this will become the top left-hand corner of the text box.
Drag the mouse to where the bottom right hand corner is to be located.

The Set Text window opens (Fig 13.2)

SNPPO!\’!—‘Ii

Set Text !
Text
Text]
— Text Alighment Text Direction
= Left =" Horzontal
% Centre 0 Wertical
¢~ Right
™ lrwert Colowrs T Fill Background
Cancel | JFE. I

Figure 13.2 — Set Text

6. In the text box type the text to appear on screen.

7. The Alignment and Text Direction can be set, along with Invert Colours and Fill
Background

8. The text is displayed in the original text area drawn, in an appropriate size font.

9. The Draw Mode returns to Selector as default

10. To edit the size of the font click on the object, then click on one of the black dots around

the object. Drag this dot around on the screen and the font will change size
automatically.

13.2.8 Static Bitmap

Select Static Bitmap Mode .

Click on the screen, this will become the top left-hand corner of the bitmap area.
Drag the mouse to where the bottom right hand corner is to be located. This will also
set the size of the bitmap.

wn e

Note: once created the bitmap size can not be changed directly. To change the bitmap size,
the bitmap image needs to be exported to a file, a new bitmap created the required size and
the old bitmap image imported back from the file of the original bitmap image.
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The Static Bitmap Editor opens (Fig 13.3)

E/® Tiu Bitmap Editor

Image Edit Settings - Yiew Help

o\ 2] QK|

Faor Help, press F1 | | 0416 | [MUM - 2

Figure 13.3 — Static Bitmap Editor

The tools available to draw shapes using the bitmap editor are very similar to the picture editor.
The exceptions are as follows: -

a. In Text mode only Transparent and Opaque are available for background fill. The font Size
needs to set before beginning to type text, in Setting/Font.

b. A Flood Fill Tool is available. Click the flood fill tool button —-——-jand then click in the area to
be filled.

c. Zoom option. Click the zoom tool button ---jthen click on roughly the area to zoomed. A
separate window appears displaying the zoomed area.

d. Left mouse button acts as draw black on green, Right mouse button acts as draw green on
black.

| Note: The bitmap can be dynamically resized.
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13.2.9 Table Mode

il

This tool allows you to easily draw the lines for a table and enter a Table Header. Once the

table is created the number of rows and columns can not be edited directly. Boxes or lines may

be added manually afterwards.

1. Select Table Mode .

2. Click on the screen, this will become the top left hand corner of the Table

3. Drag the mouse to where the bottom right hand corner is to be located. This sets the size of
the table only.

4. The Table Creation windows open (Fig 13.4)

Table Creation I

— T able Dimensions

MHumber OF Raves 14
MHumber Of Calumnz i4

~Table Header
[ Add Table Header

T able Header Test I

[ 3D Effect

Cancel |

Figure 13.4 — Table Creation

5. Set the number of columns and rows you require.

6. Click on Add Table Header and enter Table Header Text if required.

7. The 3D effect adds an extra line on the right side of the table to give the effect of shadow.
8. Click OK to create table.

9. The table will then be drawn in the area specified at the beginning.

10. The Draw Mode returns to Selector as default.
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13.3. Embedding Data on a Graphic Menu Page

13.3.1 General

The Embedded Data types are similar to the data types on text menu pages. All data types work
the same as they do on a text page see Chapter on Embedded Data. The main difference is
how the data type is embedded on the screen.

e | [ B el % || S| Rl x| ]

Figure 13.5 — Embedded Data

To Embeded Data on the Screen

1. Choose the Embedded Data type you wish to embed.

2. Click on the screen, this will become the top left hand corner of the area the displayed data
will take up.

3. The normal embedded data type window will appear. Set-up the embedded dat type as
required (See Chapter on Embedded Data).

4. Once the embedded data type is created it is displayed in the area defined earlier, in a font
size appropriate to the size of the area.

13.3.2 Analogue Meter

b

Similar to the horizontal meter Control Techniques has added a “Needle Meter” type Analogue

Meter. It is embedded on the menu page similar to the Horizontal Meter.

To Embeded an Analogue Meter on the Screen

1. Choose the Analogue Meter Data type.

2. Click on the screen, this will become the top left hand corner of the area the displayed data
will take up.

3. The normal embedded data type window will appear. Set-up the embedded data type as
required (See Chapter on Embedded Data).

4. Once the embedded data type is created it is displayed in the area defined earlier.
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13.4. Animated Bit Map Selector

13.4.1 General
In a graphic page there is one extra embedded data type available, Animated Bitmap Selector.

13.4.2 To Embed a Animated Bitmap Selector

Choose the Animated Bitmap selector Embedded Data type.

Click on the screen, this will become the top left hand corner of the bitmap area.
Drag the mouse to where the bottom right hand corner is to be located.

The normal Animated Bitmap Selector data type window will appear (Fig 13.6).

%wwelg

Configure Animated Bitmap Embedded Data |
— Remote Data Source

Femote Mode 1D IEI

Data Type

Location
— Dizplay Farmat

MNEW AMIMATED BITMAP j Edit T able |

— EditMrite

[T Enabled
— Attributes

™ Flashing ™ Box

[T Bezel
Change Type | Cancel ] %

Figure 13.6 — Embedded Animated Bitmap Selector

Chosse the Data Type and the Location of the control register of the bitmap selector.

5. Click on NEW ANIMATED BITMAP .

6. Click edit table and the size of the bitmap icon is displayed (Fig 13.7). The size of the
bitmap icon can be changed now.

Note: Once created the bitmap size can not be changed directly. To change the bitmap size,
the bitmap image needs to be exported to a file, a new bitmap created the required size and
the old bitmap image imported back from the file of the original bitmap image.
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PP © 0w~
BE9®:

12.
13.

Set lcon Table Icon Size |
YWidth I132
Height |?E

Cancel |

Figure 13.7 — Set Bitmap Icon Size

Click OK to display the bitmap icon table.

A blank table will be displayed.

Click the Add button to display the Icon Editor (Fig 13.8).

Select a Field ID number (1-250).

Double click on the icon area in the centre of the screen. The Bitmap Editor opens the
icon as a bitmap to be edited. The Icon is displayed with a checkered design as default.
To Clear the bitmap choose Image/Clear from the main menu.

See Static Bitmap Editor for details on how to create graphic images in the bitmap icon.
Once the bitmap has been completed close the Bitmap Editor and the bitmap icon will
appear in the Icon Editor.

lcon Editor |
Field D 002 |mport |
E =port |

Caricel |

Figure 13.8 — Icon Editor
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lcon Table 1 Ed |

\ Delete |
_ x|

Edit

i Select Mode
' Decimal
" Binary

" Hexadecimal

0oz ™| futa Serl

|1_ Secons

[ Auto Mask Bits
[~ Default Entry

IEI
Export T able |
Cancel ak. | Irpart T able |

Figure 13.9 — Sample Animated Bitmap Selector

Bitmap tables can be called in 3 different modes, Decimal , Binary and Hexadecimal . This
refers to the format of the data in the register calling the text table. Also in Binary mode multiple
text table entries can be displayed the user can then scroll between these text table entries, or
set the Auto Scroll option to let the TIU to automatically scroll between all the selected entries.

13.4.3 To Edit a Bitmap table from the CTIU20X:

1. Select the text string field by pressing the Pause key.
2. Move up or down the list using the Up and Down keys.
3. Press the Enter key to select the desired text string.

13.4.4 To Export/Import a Bitmap Table

a. Export

1 Click the Export button.

2. Enter the location of the file.

3 Enter the name the file the text table is to be exported to.
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b. Import
1. Click the Import button.
2. Click on the file to be imported.

13.4.5 Default Bitmap Table ID Entries

If an undefined value is entered into the Field ID table entry field (i.e., a value that has not been
assigned in any bitmap table), then one of two different things happen.

1. If the user has assigned a value to the Default Entry in the Text Table box, then that entry
number is displayed. This value is assigned by first checking the box next to Default Entry ,
then entering a number in the box below.

2. If the box is unchecked and a default entry has not been selected, then a blank bitmap is
displayed.

13.4.6 Draw Attributes

The properties or Attributes of a shape can be set before or after the shape is drawn.

Set Properties Ed |

" Sold
%' Dashed
" Hidden [Transparent] " [Dotted

™ Dash Dot
"idth I'I

—Fill
" Pixel On [Elack]
¢ Pixel O [Green]
" Transparent

Cancel | ] I

Figure 13.9 Draw Attributes
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14. NETWORKING

14.1. General

There is now a networking option available with the CTIU101/111/201. These units support
Device Net and CsCan network protocols. This chapter will discuss the registers used for
network communication and how to configure the TIU units for network communication.

14.2. Network 1/O

The CTIU101/111/201 units contain a special set of registers called Global Network 1/O, or
simply Global 1/0. Using the CsCan protocol these bits are automatically sent through the
network to all other units on the network. Anyone unit can be made aware of the activities of any
other unit on the network, and any one unit can send a signal to any or all other unit on the
network.

There are four (4) types of global registers available - %IG, %QG, %AIG, and %AQG. The
model defines the type and number of global registers available in any given model.

The global ‘I’ registers contain an image of global ‘Q’ registers located in a different unit
connected to the network. The association between | registers and ‘Q’ registers is set at the
destination unit.

Any ‘I' register may be associated to one and only one ‘Q’ register, but that ‘Q’ register may be
located in any other unit on the network. Any ‘Q’ register is broadcast on the network for any or
all other units to use.

Table 14.1 - Registers

Type Function Retentive Description
Specially defined analog inputs that come
%AIG Network Analog Input No from the CsCan

network protocol. Data is in words.

Specially defined analog outputs that go to

%AQG | Network Analog Output No the CsCan network protocol. Data is in
words.
%IG Network Digital Input No Single bit registers that come from the

CsCan network protocol.

Specially defined digital outputs that go to the

0 -
6QG Network Digital Output No CsCan network protocol,

14.3. Configuring the CTIU101/111/201 for Network Communication.

16 From the main screen of the CTIU software select Network from the drop down
Configuration menu.

17 From the Configure Network screen select the node ID and the appropriate network
protocol.
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Configure Metwork

Metwork Type

MNode 1D IU
— Dutput Table

— Input Table
Bits

ZIG1-%1GE4 | | Bits

TatleSizes |

ZUGT-Z0GE4

%G1
%ZIG2
ZIG3
%64
%G5
#IGE
G

IR
4

i’ Z0GT

Z0G2
ZOGE3
Z0G4
0G5
Z0GE

ZUGTY
_|L| z]m
» 4

e

B

ZAIGR
A

Words ZAIGT-ZAIG32 | | Words ZAQGT-#ANG32
%AIG1 a EALGT N
%AIG2 ZAQGZ
%AIG3 ZAQG3
#AIGA ZAQGA
#AIGE ZAQGS
ZAIGE ZANGE
ZAIGT ZALGY

hd ZANGA
3 4

B

Cancel | ak. I

Figure 14.1 - Network Configuration (Read)

3. From this screen the network inputs and outputs are also defined. To configure a unit to
read a single bit register from the network, select a specific %IG register from the list, by
double clicking on the name of the register. As per Figure 14.2 enter the network ID of the
data source and the specific register (%QG) from that network ID.

Configure Network Input

]|

- [ata Source
¥ Enahble

Source Metwark [0 i
Source Data  ZA0G !

- [ ata Destination

Drarget Miode L IEI

Data Type I'W'u:uru:ls j
Reaister |EI Bit
15 Bit = 32 Bit
[ TransmizsionT imeout
Ok I Cancel

Figure 14.2 - Configure Network Input

4. The data read from the %QG register can be directly sent to a specific register
automation equipment. From figure 14.2 enable the Data Destination box and define the
automation equipment register that %QG1 is to be sent to.
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5. To configure units to write a single bit register to the network select a specific %QG register
from the list as per Figure 14.3 by double clicking on the register name.

Configure Network E2 |

Metwark Type IEsEan j Made D IZ'I 1 ahle Sizes |
— Input T able — Output T able

Bitz ZIG1-%1GE4 | | Bitz Z0G1-E20GE4
%G1 i’ _
EAIENS ¥OG2

EAIEK] EQG3

ZlGd ZOGA

ZIG5 #0G5

%GE EQGE

ZIG7 OGS

#IER _ILI AR _lﬂ
4 i | 3 4 I | 3
Wwiords EAIGT-2AIG32 | | Words ZAQGT-ZAQG32
ZAIGT - #ADGT -
ZAlG2 HALG2

ZAIG3 ZL0G3

ZAlG4 HALNGA

ZalGh HA0GE

ZAIGR ZoLGE

ZAIGT ZALGT

| e _|;I HANGA _IL|
4 i | 3 4 i | 3

Cancel | Ok I

6. From the Configure Network Output

Figure 14.3 - Configure Network (Write)

window (Figure 14.4) enable the Data Source box

and define the automation equipment register that is to be outputted to the network. The
Scan Period determines how often the network checks the value in the register for

changes.
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Configure Network Output ;

W Enable :
~Data Sounce
Tergethode(n i
Data Type IWDrds j
Reqister IEI— Bit I_
" 15 Bit 22 Bit

Scan Period I % 100 mzecs
| k. I Cancel |

Figure 14.4 — Configure Network Output

7. Similarly the CTIU101/111/201 units support the transfer of words over the network. This is
done using the %AIG registers for inputs and the %AQG registers for outputs.
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15. MATHEMATICS

15.1. General

The CTIU10X/11X/20X now contains a Mathematic Interpreter. Up to 1024 lines of Mathematic
Statements can be programmed into the terminal, and these can be split into function blocks
which are called by the system as required. The function blocks are called on any of the

following basis...

Table 15.1 — Call Methods

Call Method Description
Background Tasks At regularly repeating intervals, definable down to 0.01
seconds

Scheduled Tasks

At a particular time (HH: MM) on specified days of the week

Function Key Presses

As function keys are pressed

Dialog Linkages

To initialise operator dialog sequences and also as keys are
pressed in operator dialog sequences

One Shot Communications

On successful or failed one shot communications blocks

15.2.

Internal & System Registers

The available internal registers are as follows: -

Table 15.2 — Register Names

Description Name Available
Bit Input SmartStack %l Only if SmartStack Configured
Bit Output SmartStack %Q Only if SmartStack Configured
Word Input SmartStack %Al Only if SmartStack Configured

Word Output

SmartStack %AQ

Only if SmartStack Configured

Internal Word Register

Internal %R

Only if Maths Configured

Internal System Register

Internal %SR

Only if Maths Configured

Internal Bit Register

Internal %M

Only if Maths Configured

Network Word Output Network %AQ Only if Network Configured
Network Word Input Network %Al Only if Network Configured
Network Bit Output Network %Q Only if Network Configured

Network Bit Input

Network %l

Only if Network Configured

CTIU User Manual Issue 2

MATHEMATICS

PAGE 119




The Internal System Registers available are as follows: -

Table 15.3 — System Registers

Name Read / Write Description
%SR01 R/W Contains the current page ID
%SR02 R Contains the state of the up/down/pause/enter keys.
%SR03 R/W Contains the Global drive Network Address
%SR04 R/W Contains the current password
%SR05 R/W Contains the current edit status (V4.10n onwards)
%SR11 R Contains the RTC seconds
%SR12 R Contains the RTC minutes
%SR13 R Contains the RTC hours
%SR14 R Contains the RTC date
%SR15 R Contains the RTC month
%SR16 R Contains the RTC year
%SR17 R Contains the RTC number of days in current month
%SR18 R Contains the RTC number of the day in the year
(eg. 1* February = 32)
%SR19 R Contains the RTC day of week
%SR21 R Contains number of accepted alarms
%SR22 R Contains number of unaccepted alarms
%SR23 R/W Contains the total number of attempts to the drive (Writing
any values resets all comms counters)
%SR24 R/W Contains number of good comms transactions
%SR25 R/W Contains number of bad comms transactions
%SR26 R/W Contains number of no comms transactions
15.3. Maths Functions

Maths functions may be used for a variety of purposes.
1. Maintaining Internal Variables

2. Controlling Database Operations

3. Generating Alarms

15.4. Execution of Maths Functions

Maths functions are called by starting at a specified line. The lines are processed consecutively
beginning at the start line until a line with a *END* marker is processed, or the end of the maths
listing is reached. Control may be switched using a GOTO statement in the function block or
using any of the conditional statements, which will jump to another line or END marker.

15.5. Mathedit Windows Application

To view and modify the contents of the Mathedit Application, click the mathematics icon from

the tool bar El or choose Maths from Configure in the main menu, the Mathedit Application
window appears (Fig 15.1).
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- Mathedit Windows Application
File Edt Opcode “Wiew Help

B=(E| S| &[=[@| [F] = ||w| Al ool

10 hd
For Help, press F1 P LIk o

Figure 15.1 — Mathedit Application Window

15.6. Opcodes

The available operational statements are: -
1. No Operation —|

2. Conditional £|

3. Assignment il

4. Bit Operation ﬂl

5. Table Operation ml

6. Function @l
7. Control Flow ﬁl

EMND
8. Set End —|

15.6.1 No Operation

L

This statement causes the line to do nothing. The statement shows as a blank line.

15.6.2 Conditional

£|

This statement compares the contents of a local store register with either the contents of
another local store register or a constant. After which an action is completed, depending on the
result of the comparison.

The available Comparison Tests are:
1. Equal ;l
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<

2. Not Equal —|
<

3. Less Than —|

£=

4. Less Than or Equal —|
=

5. Greater Than or Equal —|

b
6. Greater Than —|

7. And il
8. Or—||

Conditional Statement |

— Test
Reqister R egister/Conztant

[= =l |%rooor
S e I T

—&chion
@+ SetBit | G000 Bit I
" Teminate Function
™ Jump To Line I“END .

Cancel | ] I

Figure 15.2 Conditional Action

Conditional Action
If the result of the test is true than the chosen action is executed.

| Note: The And and Or statements are true if the result equals not zero.

1. SetBit
Sets the bit in the specified Local Store Bit Register.

2. Terminate Function
Terminates the function. An End statement is put at the end of the line statement.

3. Jump To Line.
Jump to specified line number or End
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15.6.3 Assignment

This statement assigns a value to the specified local register. The value of the register can be
mathematically manipulated before storing it the local register.

Aszzignment Statement |

Reaqister (D Reqister |d Heqreten|d L Eomstart

= |%R0001 | =l

I V| e |
Cancel | [ ok ]

Figure 15.3 — Assignment Statement

The available mathematical functions are: -

1. Equal—|

This function makes one Register equal another register.

2. PIus—+|

This function lets the programmer add the contents of a register to the contents of another
register or constant and stores the result in the specified register.

3. Minus —|

This function lets the programmer subtract the contents of a register or constant from the
contents of a register and stores in the result in the specified register.

4. Multiply ]

This function lets the programmer multiply the contents of a register by the contents of another
register or constant and stores the result in the specified register.

5. Divide Ll

This function lets the programmer divide the contents of a register by the contents of another
register or constant and stores the result in the specified register.

%
6. Percentage—|

This function lets the programmer multiply the contents of a register by the contents of another
register or constant and stores the result as a percentage of the first register in the specified
register.

7. Andil

This function lets the programmer AND the contents of a register with the contents of another
register or constant and stores the result in the specified register.
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8. Or—ll

This function lets the programmer OR the contents of a register with the contents of another
register or constant and stores the result in the specified register.

9. Exclusive Or—l

This function lets the programmer XOR the contents of a register with the contents of another
register or constant and stores the result in the specified register.

Note: Indirection is allowed on the %R local registers, e.g. %R10 = %R(%R40) + %R(%41). If
%R40 contain 100 and %R41 contains 11, then %R10 will be sum of the contents of %R100
and %R11.

15.6.4 Bit Operation

ﬂl

This operational statement can perform 4 different operations on a local bit register.
1. Setthe bit

2. Clear the bit

3. Invert the bit

4. Pulse the bit

Bit Operation Statement

Eit | dentifier
=| [zac0001

Figure 15.4 — Bit Operation Statement

1. Set
Changes the bit value to 1

2. Clear
Changes the bit value to 0

3. Invert
Changes the bit value to 1, if present value is 0, or changes the bit value to 0, if present value is
1.

4. Pulse
Sets the specified bit high for 1 second and clears it to go low.
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15.6.5 Table Operation

|

This operation statement performs a number of operations on a specified table. As per figure
15.5 the table definition is defined as the number of local registers in the table beginning at the
specified local register.

Table Operation Ed |

T able Definition

R egister 1D

I'I 1] Fiegisters starting at I?r;FiEIEIEI'I

EER -

T arget Feqgister IKH oam

Cancel | (] I

Figure 15.5 — Table Operation Window

The available operations are:

Total
Average
Maximum
Minimum
Move To
Swap With
Reset

NouokrwbdE

1. Total
This action sums the contents of the registers and stores the result in the target register.

2. Average
This action averages the contents of the registers and stores the result in the target register.

3. Maximum
This action searches the contents of the registers and stores the maximum value in the target
register.

4. Minimum
This action searches the contents of the registers and stores the minimum value in the target
register.

5. Move To

This action moves the contents of the registers in the table as a memory block, to a memory
block beginning at the target register
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6. Swap With
This action moves the contents of the registers in the table as a memory block, with a memory
block beginning at the target register

7. Reset
This action resets the contents of each of the registers in the table to zero.

15.6.6 Function
fix)

This action performs a function on the contents of the specified action and stores the result in
the same register or another specified register. The available functions are: -

Root

This function puts the square root of the contents of the first register in the second specified
register.

ToBCD
This function converts the contents of the first register to Binary Coded Decimal and stores it in
the second specified register.

FromBCD
This function converts the contents of the first register from Binary Coded Decimal and stores it
in the second specified register.

15.6.7 Control Flow

A

This action allows the programmer to perform simple program flow commands within the
mathematic function. The available commands are: -

1. Pause
2. Goto

3. Gosub
1. Pause

This command allows the programmer to pause the mathematic function for a specified number
of seconds.

2. Goto

This command allows the programmer to jump to a specified line number of the end of the
function.

3. Gosub

This command is similar to the Goto command however when an End command is reached the
program flow returns to line immediately after line where the Gosub command was executed.

15.6.8 Set End

EHDl

This action denotes the end of a mathematic function.
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15.7. Background Functions

The CTIU10X/11X/20X terminals background function facility allows the terminal to continually
run up to 8 maths functions automatically, without operator intervention. These functions can be

programmed to run repeatedly after a specified time interval or be executed once on

initialisation of the terminal.

To program a background function, choose Background Functions

from Edit menu, in the

Mathedit Application Window.  Figure 15.6 shows the background function set-up window.

Background Functions

]|

1. ¥ Enable [ Restart Function Every I Secs Call |1|
2 ¥ Ensble [ Bestart Function Every I Secs Call I
3 |V Enable [ Bestart Function Ewvery I Secs Call I
4 |V Ensble [ Bestart Function Ewvery I Secs Call I
5 |V Enable [~ Restart Function Ewvery I Secs Call I
B ¥ Enable [~ Restart Function Every I Secs Call I
I ¥ Enable [ Bestart Function Every I Secs Call I
8 |V Enable [~ Bestart Function Ewery I Secs Call I
Cancel | k. I
Figure 15.6 — Background Function Set-up Window
15.7.1 To Program a Background Function

1. Enable one of the 8 background functions by clicking in the tick box next to the number of

the background function.

PN

begins.
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15.8. Schedule Functions

Scheduled Functions have been provided as a means of initiating functions on a time and day
basis. There are 16 schedules available each of which specifies a time of day and day of the
week at which a Maths Function is to be called.

To configure the scheduled functions for the TIU terminal select Scheduled Functions from the
Edit menu.

Scheduled Functions |
Time 5 M T W T F 5 Call
1 | Enable IW r v rrrr T
2 [ Enable IW rr - r - - - 1}
3 [ Enable IW o o o o o o o -
4 [ Enatle IW d d o d o O o -
5 [ Enable IW ERE T T e 7
E [ Enable IW rr r rrr rr n
7 I Enable IW d d o d o O o -
8 [ Enable IW d d o d o O o -
3 [ Enable IW r rrrrrr 7
10 [ Enable IW FE T EEEE i
11 [ Enatle IW ERE T T e =
12 [ Enatle IW o o o o d o o 5
13 ™ Enatle IW ERENENERERERE T
14 [~ Enable IW rr - r - - - 1}
15 [T Enable IW d d o d o O o -
16 ™ Enable IW o o o o o o o -
Cancel | ITI

Figure 15.7 - Schedule Functions Window

15.8.1 To Set-Up a Schedule Function

1. Enable the schedule by clicking on the tick box corresponding to the schedule number.

2. Inthe Time enter the time of day at which the function is to be executed.

3. Click the day or days on which the function is to be executed.

4. Inthe Call field enter the mathematic function to be executed, this is the line number of the
mathematic function.

15.9. Data Transfer Block

Local registers in the terminal can be mapped to registers in the automated equipment using the
Data Transfer Block facility.

CTIU User Manual Issue 2 MATHEMATICS PAGE 129




15.9.1 To Add a Block Transfer
1. From the Edit menu choose Data Transfer Block .

Map PLC Regizters Into Local %R Registers

b4 apping

Edit

Welete

L]

Cancel |

Figure 15.8 — Data Transfer Block

2. Click on the Add button to add a Map Register Statement. Figure 15.9 illustrates the how
the registers are mapped.

3. Enter the Data Type Register and Location of the automated equipment registers.

4. Enter the block size or the number of registers to be mapped.

5. The registers maybe mapped in two directions, from the terminal to the automated
equipment or from the automated equipment to the terminal. Choose which transfer
direction.

6. The Period is the time interval between data transfers. In the Period field enter how often
the data is to be transferred.

7. Finally enter the first local register where the data is to be transferred to or transferred from.
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Data Type IWnrds j

Location ||:|
Block Size IEI

"Transfer Direction

& ToTiu ¢ From Tiu

Ferod |00.0  Secs

Tiu D ata Starts at =R |1

Cancel |

Figure 15.9 — Mapping PLC Registers and Local
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16. SmartStack O

16.1. General

Control Techniques has now added the SmartStack[D modules to the CTIU20X range. The
SmartStack system is a method of allowing 1/0O expansion on an HMI. As well as CTNet, a wide
range of Digital and Analogue 1/0 modules is available.

16.2. Installing and Removing a SmartStack Module

The following section describes how to install and remove a SmartStack Module.

Caution: To function properly and avoid possible damage, do not install more than four
Smart Stack O Modules per CTIU20X.

a. Installing SmartStack Modules

1. Hook the tabs. Each SmartStack Module has two tabs that fit into slots located on the
CTIU20X. (The slots on the CTIU20X are located on the back cover.)

2. Press the SmartStack Module into the “locked” position, making sure to align the
SmartStack Module fasteners with the SmartStack receptacles on the CTIU20X.

b. Removing SmartStack Modules
1. Using a Flathead screwdriver, pry up the end of the SmartStack Module (opposite of tabs)

and swing the module out.
2. Lift out the tabs of the module.

Fastner

SmartStack Tab

Connector pins.___"

T
|00000000||00000||°°°|

ad

CTIU 200

Figure 16.1 — Installing a SmartStack [0 Module in an CTIU 200.
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16.3. Configuring SmartStack Module

At this time the range of compatible SmartStack modules for the TIU range is as follows: -

Table 16.1 — SmartStack Modules
Module Description

HE800ADC110 4 channel Analog Inputs, Voltage (0-5vdc, +/-5vdc, 0-10vdc,
+/-10vdc), 12 bit

HE800DIQ511 4 Channel 12/24 Vdc Digital Input Pos/Neg logic 4 Channel
12/24 Vdc Digital Output Neg logic

HE800DIQ512 4 Channel 12/24 Vdc Digital Input Pos/Neg logic 3 Channel
Relay Output

HE800DIQ522 4 Channel 120 Vac Digital Input Pos logic 3 Channel Relay
Output

HE800DIQ611 8 DC Inputs (12/24vdc, pos/neg logic), 8 DC Outputs
(5/12/24vdc, 0.5A, neg logic)

HE800DIQ612 8 DC Inputs (12/24vdc, pos/neg logic), 6 Relay Outputs
(250vac, 30vdc, 4.0A)

HE800DIQ622 8 AC Inputs (120 vac), 6 Relay Outputs (4.0Aper point)

Click on the SmartStack Configuration icon or choose SmartStack I/O from the Configuration
menu.

From the Configure SmartStack I/O window, click on the pull down menu for the appropriate
slot.

The available modules are listed, choose the module to be installed.

Configure Smart Stack 1/0 |
Slat 1 ILlnassigned j
Slat 2 ILlnassigned j
Slat 2 ILlnassigned j
Slat 4 ILlnassigned j

Cancel |

Figure 16.2 — SmartStack Configuration
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16.4. SmartStack 1/0

The input and output of the smartstack is handled within the local registers of the terminal. The
local registers and therefore the 1/0 of the smartstack is then analysed or manipulated within the
Mathedit Application of the CTIU software. See chapter 15 for more information on the Mathedit
Application.

16.5. Module Addressing

The base addressing for the slots are as follows: -

Table 16.2 Base Address
Slot Base Address

1 00001

2 10001

3 20001

4 30001

The input and output register names and addresses are as follows: -

Table 16.2 I1/O Address

I/O Type Address

Bit Input %Innnnn

Bit Output %Qnnnnn
Word Input %AInnnnn
Word Output %AQnnnnn

>

nnnnn = the base address of the module

The base address begins at nnnnX and is incremented by 1 to the
last channel on the module. (X = 1 or 0 depending on the bit base
numbering set-up under Configure/Bit Base Numbering, default is 1)

o
*

R/
0.0

All examples below assume Least Significant Bit for Internal References is setto 1.

E.g. the third bit of a Digital Input module in slot 3 would have the address of %120003.
E.g. the fourth bit of a Digital Output module in slot 3 would have the address of %Q20004.
E.g. the third channel of an Analogue Input module in slot 4 would have the address of
%AI30003.

Note: Digital Input modules can be read as words or bits by selecting the appropriate register type. Digital
Output modules can be written to as words or bits by selecting the appropriate register type. The system
will strip off any redundant bits within the word.

16.6. Displaying Data From SmartStack

Data from SmartStack modules can be embedded into a menu page in exactly the same way as
other Automation Equipment devices. Embed the data type as normal and select the Location
from the range of “Smart 1/0O” register types shown in the pull down register table. The normal
function can then be applied to the register value, i.e. Range Checking, Scaling etc.

Note: The numeric default settings for Analogue modules should be set to 16 bit and signed.
Output data can be edited / scaled using the screen editor in the same way as a normal AE.
Data to / from SmartStack can also be scaled or manipulated via the Maths.

Note: The numeric default settings for Analogue modules should be set to 16 bit and signed.
Output data can be edited / scaled using the screen editor in the same way as a normal AE.
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It is not possible to read and then modify Output types directly within a TIU system. If itis
necessary to do this, it is better to use a System %R register within the Maths facility to
manipulate and hold the “master value” then assign the actual value to a %AQ register. See
Chapter 15 Mathematics on writing and calling maths functions.

Again, it is good practise to write to an Output type at only 1 point in the configuration.

5 XRO005 = *ROO0OS = Z

6 IF ZR000S > 128 GOTO 10
7 IF ZRE00OOS = 0 GOTO 10
g8 xA00001 = ZR0O005

.9 ZAQiOAnl = ¥ROOMS. . = FND %
10 %R0O0S = 1
11 30TO 8
Figure 16.3 — Math Example Word
16.7. Considerations for Shutting Down & Restarting a CTIU20X with
1/0O

During a “shutdown” for downloading, it is possible to leave SmartStack outputs on. It is
therefore important to make sure that all outputs are in a safe condition before this operation is
carried out.

For example, this could be implemented using a dedicated Function Key labelled SHUTDOWN
to call a Maths function that set any SmartStack outputs to a safe state for shutdown.

During a restart either from a “Power Up” or from after a download, SmartStack outputs may not
always be in the mode required. This situation could be overcome by calling a Restart Maths
function to correctly initialise the SmartStack output modules.

Examples are shown below

25
2b ZAQDOOL = 7
27 %A010001 = 0
28 %AQZ20001 = -3000
A+ [IM12_=_Z10 B £

Figure 16.4 — Math Example Set Outputs for Power

Function Key Definition x
Global Function Key Definition | Rey Typa-—
: 1]
Key Action IExecute haths IJ i & Global
25| | 5(" Local

kaths Function

Figure 16.5 — Calling Math Function From Function

Background Functions

= EestarmEunction Eveny i SElEe Call I

2 ¥ Enable ¥ Restart Function Ewery {000 Secs Call 26

Figure 16.6 — Calling Math Function from Background
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